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Licensing Information

There are two types of licenses available for ProPresenter. Both forms of the license refer to a single
geographical location. If your church or organization wants to use ProPresenter in multiple geographical
locations, each location is required to own its own license.

A SINGLE USER LICENSE grants permission for one (1) computer to be used as the presentation
computer at a given time. The license may be installed on an unlimited number of computers for editing
purposes or for CONCURRENT (non-simultaneous) presentation use. A SINGLE USER LICENSE removes
the watermark from one presentation computer at a time. A SINGLE USER LICENSE is platform specific
to Mac or Windows.

A SITE LICENSE grants permission for an unlimited number of computers to be used as the presentation
computer simultaneously. Any computer with an active SITE LICENSE may be used as an editing or
presentation computer at any time. The watermark is removed from all computers with a SITE LICENSE.
A SITE LICENSE may be activated on both Mac and Windows computers simultaneously.

Planning Center Online (“PCO”) is wholly owned by Ministry Centered Technologies, LLC (“Ministry
Centered Technologies”). License fees may apply and are the sole responsibility of the user.

SongSelect is wholly owned by Christian Copyright Licensing, Inc. (“CCLI”). License fees may apply and
are the sole responsibility of the user.
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Installing ProPresenter

When you are ready to download and install ProPresenter, go to the Renewed Vision website.
Under Download in the menu bar, select ProPresenter. You will then click on the Download
Now option for the Mac version.

When you click on Download Now, the disk image (.dmg) will begin downloading automatically.
“Disk Image” is the term used to describe the file used to package installation files for Mac OS X.

(&) Opening ProPresenter5_5.0_b6498.dmg

You have chosen to open

_| ProPresenter5_5.0_b6498.dmg

which is a: dmg File (24.1 MB)
from: http://www.renewedvision.com

What should Firefox do with this file?

() Open with ( Choose...

GSave File

| Do this automatically for files like this from now on.

"~ Cancel (——OK—)

Select “Save File” and then click OK to continue with the download.

_ After the download completes, locate the file in your Downloads folder in the Finder,
— | and double-click on the disk image icon to open the installer utility. You can also
— open the file location through the Downloads manager in your web browser if you
can’t locate your Downloads folder.

© 2011 Renewed Vision, Inc. Page 1 of 131
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When you open the disk image, you will be shown the licensing agreement. Read and make
sure that you understand the license terms and then click Agree to continue with the
installation.

ProPresenter5_5.0_b6498.dmg

If you agree with the terms Renewed Vision, LLC. Software End User License Agreement

of this license, click "Agree® m
to access the software. If NOTICE TO USER: THIS SOFTWARE END USER LICENSE AGREEMENT
you do not agree, press ("EULA") IS A LEGAL AGREEMENT BETWEEN YOU AND RENEWED
“Disagree." VISION. READ IT CAREFULLY BEFORE COMPLETING THE

INSTALLATION PROCESS AND USING THE SOFTWARE. IT PROVIDES
A LICENSE TO USE THE SOFTWARE AND CONTAINS WARRANTY
INFORMATION AND LIABILITY DISCLAIMERS. BY INSTALLING AND
USING THE SOFTWARE, YOU ARE CONFIRMING YOUR ACCEPTANCE
OF THE SOFTWARE AND AGREEING TO BECOME BOUND BY THE
TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS
OF THE LICENSE, YOU MAY RETURN THE RENEWED VISION
SOFTWARE TO THE PLACE WHERE YOU OBTAINED ITFOR A
REFUND. FOR RENEWED VISION SOFTWARE INCLUDED WITH YOUR
PURCHASE OF HARDWARE, YOU MUST RETURN THE ENTIRE
HARDWARESOFTWARE PACKAGE IN ORDER TO OBTAIN A
REFUND. IF YOU ARE ACCESSING THE SOFTWARE
ELECTRONICALLY, SIGNIFY YOUR AGREEMENT TO BE BOUND BY
THE TERMS OF THIS LICENSE BY CLICKING THE "AGREE/ACCEPT"
BUTTON. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, 4
CLICK "DISAGREE/DECLINE".

v

Print ) ( Save.. ) ( Disagree ) [ Agree

After agreeing to the license terms, the disk image will be opened. To install the application on
your computer, click on the ProPresenter icon and drag it across the gray arrow onto the
Applications folder. This will install ProPresenter in your Applications folder in Finder. Since
ProPresenter 5 has a unique name and files, it can be installed simultaneously with ProPresenter
3 or ProPresenter 4.

ANO |_| ProPresenter5 —
2 2 items, 24.7 M8 available —O—

17 W
N

”
Applications

‘@ RenewedVision rog he Propresen

Enhancing Environments threugh Technology

ProPresenter 5

You can now close the installer window and launch ProPresenter 5 from your Applications folder
in the Finder.
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You will see the message shown below the first time you launch the program, click Open to
continue.

“ProPresenter 5” is an application
downloaded from the Internet. Are you
sure you want to open it?

Firefox downloaded this file today at 11:37 AM.

(‘3\ “ Cancel ) [ Open

When ProPresenter launches, you will be prompted to enter your License Registration
information. This information is provided to you electronically after purchasing a license or
when you request a trial code.

Note: A single user license is platform specific, so a Windows code won’t work in the
Mac version and a Mac code won’t work in the Windows version. Each version of
ProPresenter (3, 4, and 5) have unique codes, so your previous codes won’t be able
to unlock Pro5.

If you have not purchased a code, or don’t have a trial code, you can choose to either purchase a

code by clicking on “Buy Now” or open ProPresenter by clicking on “Demo”. The demo version is
fully functional, but it does have a watermark on the main output and the stage display output.

IPlIiOJ License Registration

Registered To: .
Unlock Code:

V oo Y .
@ Buy Now .\ Demo /( Submit )

If you receive a message saying your code is invalid, check the following things:
e Is your code a ProPresenter 5 code?
If it’s a single user code, is it a Mac Single User code (starts with ‘M’)?
e Are you entering the 25-digit code? Is it five sets of five alphanumeric characters?
¢ Did you include the dashes in the code if you manually entered it?
e Is there an extra space on the end of the Unlock Code if you copied/pasted it?
« Did you transcribe any letters/numbers incorrectly?

Before contacting us directly, please go to www.renewedvision.com/support and attempt to
retrieve your registration information. If you purchased from a reseller and need to redeem your

activation code, please go to http://www.renewedvision.com/registration.php.

Once you have successfully entered your license information you will be asked to enter your
user account password for your computer. We can’t help you if you don’t know this password.
© 2005-2012 Renewed Vision, Inc. Page 3 of 131
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Info Center

The first time you launch ProPresenter you will see the ProPresenter Information Center. You
can access this later by clicking on the ProPresenter logo in the upper-right corner of the
application. Uncheck the “Open Info Center after Launch” option at the bottom to prevent this
screen from opening every time you launch the program.

x EIEAER G wo " sore [§ songselet

ProPresenter Information Center

Import Pro Library P> Install Sample Library a Download User Manual

mywwmm Add a sample of s0ng presentations. WBHl.  Our comprehensive POF guids fo
nio ProPresenter 5 1o your Rorary T using ProPresenter 5

Video Tutorials ProPresenter FAQs Looklng for great content?

— ~ Visit our Media Store
A — k here 1o waich our For quastions and %ps on . -
m FREE video wiorials | We using ProPresentar, be sure
have nearly an hour long 10 check our Frequently \,
tour of how 10 use the Asked Quastions page o <
software 50 you can have where wo've aready A
M uwmnmmgum answared our most R /
ProPresenar o o ‘ commony asked questions -

Forgot your Unlock Code? More Questions?

)
. Enter the email a0dress used when you made your purchase and
. st S00 the
well send the information back 10 fhat address User Forums - Post 10 or search our forum for the
.,/; Quickest answers from s:a and cusiomers.

Retrieve )

__ Open Info Center after Launch

Import Pro Library ProPresenter will detect whether you have ProPresenter 3 or ProPresenter 4
installed automatically. When you click on this button, the correct import utility will open. If you
have both versions installed, the newer version will be used. Importing libraries is covered in
more detail later in this user guide.

Install Sample Library This will install a small collection of public domain hymns. There is no
need to install these if you don’t use old hymns.

Download User Manual This will download a copy of the user guide as a PDF to your computer.

Video Tutorials The ProPresenter 5 tutorial videos can be viewed directly in the program. An
internet connection is required

ProPresenter FAQs This will load our FAQ page. An internet connection is required.

Looking for great content? This button will launch our media store page where you can
download the free samples or buy additional content.

Forgot your Unlock Code? Enter the email address that was used to buy ProPresenter to have
your registration information resent.

More Questions? This link will take you to our user forums where you can get more help.

© 2005-2012 Renewed Vision, Inc. Page 4 of 131
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Free Media Content

We have partnered with WorshipHouseMedia to power the media store that is accessible
directly through ProPresenter. If you have purchased anything from WorshipHouseMedia
before, you will be able to use those credentials to log into the store, otherwise you will create a
new account during the check out process that you can then use in the future to buy additional
media.

To access the Store and the free content, click on the Store icon in the toolbar then select the
RenewedVision Video Sample Download link. Depending on the size of your screen, you may
have to scroll down a little to see this banner. If nothing is loading on this page, ensure that you
have the latest version of Flash for Safari installed.

Everyone who purchases a ProPresenter 5 license (new or upgrade) is qualified to receive 60
free motion backgrounds from Centerline New Media, CreationPower Media, Graceway Media,
Igniter Media, pixelgirl media, and Playback Media.

If you have purchased a site license, you will also have access to 50 additional clips from 12 Inch
Design, Igniter Media, WorshipFilms.com, Midnight Qil PRoductions, and Highway. If you are a

current Pro4 user, this is the same bundle you already have access to.

All users also have access to an additional 120 still images. A download link is provided to these
files in your purchase receipt.

LOGIN / REGISTER

RenewedVision
MEDIA STORE

‘TIS THE SEASON

MINI-MOVIE FROM DAN STEVERS

> = FREE
RenewedVision

the plavlist

The s used by your tavorti arsists.
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The next page that loads will have a blue button that says “Add All to Cart”. Click that button to
continue the process. The rest of the check out will be guided by on-screen prompts. Follow
those until you get to the final download page then click the download buttons next to each

bundle. They will automatically be downloaded into ProPresenter and will show up in your
Purchased folder in the Video/Image Bin.

Nosore [ sengselect

4. RenewedVision
MEDIA STORE

ProPresenter Video Sampler

FREE For Eiigbie ProPresartar Owrars *

centerline
@ |x-e| irl media
IGNITER MEDIA

Media

/Q-‘

,o®
worship house media
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Configuring your computer for first use

If this is the first time you are setting up a computer to use ProPresenter, there are a few things
you need to do first to optimize your experience. The most important thing is to make sure your
screens are properly configured, which is covered below. There are some additional links to
online resources that we think you will find useful while setting up your computer.

System Display Preferences

The first step to getting your displays configured correctly is making sure that your system
display preferences are set up properly. Before you begin, connect your primary output to your
computer. Setting up the Stage Display will be discussed later in this manual.

To access Display Preferences, click on the Apple menu in the top-left corner of your screen and
select System Preferences. Click on Displays to open up the display preferences.

Hardware

(=

— = o
CDs & DVDs Displays Energy
Saver

After Displays is opened, click on the Arrangement tab. Ensure that the Mirror Displays option is
unchecked. You can also do this by pressing Command-F1 on your keyboard.

8e00o Color LCD

(<[> [showar ] L

! Display | Arrangement = Color '

To rearrange the displays, drag them to the desired position.
To relocate the menu bar, drag it to a different display.

|_! Mirror Displays

[ Show displays in menu bar [ Gather Windows ( Detect Displays ) @

Your Display resolutions should be correct automatically, but if you need to make a change to
your external display resolution, click on Gather Windows, select the Display Preferences for the
external display and change the resolution.

© 2005-2012 Renewed Vision, Inc. Page 7 of 131



ProPresenter 5 for Mac User Manual

DVD settings

If this is a new computer you will need to localize the DVD playback so that it will work in
proPresenter. To do this, open the Finder, select your hard drive (“Macintosh HD”), open
Applications, double-click on DVD Player. When DVD Player opens for the first time, you will be
asked to select your region. If you live in the US, this will be Region 1. After you have selected
this setting, you can close DVD Player.

If you forget to do this, the first time you try to use a DVD in ProPresenter, it won’t work and
you’ll need to come back to this step.

It is also recommended that you turn off auto play settings on your Mac to prevent resource
conflicts between DVD Player.app and ProPresenter’s DVD player. To find these settings, open
System Preferences then click on CDs & DVDs under the Hardware options. Change the When
you insert a video DVD option to Ignore.

e N CDs & DVDs
[ «[» ][ Showan | Q
When you insert a blank CD: | Ask what to do ﬂ
When you insert a blank DVD: ' Ask what to do T]
When you insert a music CD: | @ Open iTunes T]
When you insert a picture CD: | 7% Open iPhoto T‘
I When you insert a video DVD: | Ignore T‘I *C_I\‘

When you need to use your computer to watch a DVD you will need to manually open DVD
Player.app from your Applications folder. This settings prevents your Mac from automatically
trying to play the DVD, which can interfere with ProPresenter’s DVD functionality.

Other settings

You may also want to change your desktop image on each display to a solid color. You should
also adjust your screensaver and power options so not engage if the computer is left idle for
only a few minutes.

© 2005-2012 Renewed Vision, Inc. Page 8 of 131
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ProPresenter Preferences

This section will cover the Preference menu in ProPresenter 5. It’s likely that you will need to
make very few changes to your Preferences beyond the initial setup.

Preferences are accessed by clicking on the ProPresenter menu and then selecting Preferences,
or by pressing Command-, (Command and the comma key).

© 2005-2012 Renewed Vision, Inc. Page 9 of 131
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General

®NeO General

G EEL S0 ® g -

GCeneral Display Label DVD Live Sync Network Advanced Modules

General Settings
M Check for updates at startup Check for update

Library Folder: Default E

Default Logo:
__ Preserve aspect ratio

Check for updates at startup

This option is enabled by default. ProPresenter will automatically check for updates when the
program launches as long as you have an internet connection. If you don’t want to be notified of
updates automatically, uncheck this option, but remember to check regularly for updates.

Library folder

This menu allows you to select from multiple libraries as well as add additional libraries. Adding
additional libraries will be covered later in this guide in the section title Working with the
Library.

Default Logo

The ProPresenter logo is the default logo. You can check this by clicking on this button and
selecting your own image. Having your organization’s logo or other image here provides you
with something to go to in an emergency. Checking Preserve aspect ratio will maintain the
aspect ratio of the logo image.

Application Data
(OFor All Users  ® Only this User () Custom Path

Media Repository
@ For AllUsers () Only this User () Custom Path

__ Manage Media Automatically

Application Data

By default, the Application Data is stored per user (“Only this User”). This allows you to have
multiple user accounts on the computer and unique ProPresenter environments in each
account. If you would like to enable all of the user accounts to access this data, you can select
the “For All Users” option. This will create a new set of application data files on the root
directory (hard drive instead of user account) that each user can access. You can also store this
on a custom path if your setup requires this.

Media Repository

The first time you launch ProPresenter you will be asked where you want your default media
stored. This is the directory where any media purchased through the store is downloaded to and
where media that is imported with bundles is stored.

© 2005-2012 Renewed Vision, Inc. Page 10 of 131
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(— Would you like the Default Media folder to
Prg' be accessible by all users of this

computer or by this user account only?

© Onlythis User ) ( AllUsers )

If you choose “Only this User”, your media will be managed per user account. If you choose “All
Users”, this folder will be created in a shared directory accessible by all users. You can change
this location at anytime.

If you check the “Manage Media Automatically” option, any media that you add to ProPresenter
will be copied to this location. In previous versions of ProPresenter, adding media to the Video/
Image Bin, for example, didn’t move the original files. If you added a file from your Desktop and
then delete or move that file, the link was broken in ProPresenter. However, if you enable this
option, that file would be added to ProPresenter and automatically moved into your media
repository, preventing broken links. If you already have a well organized media storage method,
you may not want to enable this option.

Search Paths

Movies . HIE
~[Pictures
~/Renewed Vision Media

Search Paths

If you need to move all of your media from on directory to another (e.g., ~/Desktop/ to ~/
Documents/), you can add a new search path. When you restart ProPresenter, the links to your
media will all be updated.

Copyright
[2‘ Enable Copyright display License #:
@ First Slide () Last Slide Configure CCLI Layout...
(O First & Last () All Slides Reporting...

Reset All Preferences

Copyright
Copyright settings are covered later in this guide in the section called Copyright Settings. The
settings here are the global settings for Copyright display.

Reset All Preferences
This resets all the custom settings made in Preferences.

© 2005-2012 Renewed Vision, Inc. Page 11 of 131
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Display Preferences

(&) (&) Display

o mE= o B 0 O ok .

Ceneral Display Label DVD Live Sync Network Advanced Modules

Output Display Settings
__! Display at Top Most Window Layer
__! Scale to Fit Output Display
@ Enable Stage Display Configure Stage Display

Edit System Display settings

Output Screen

Screen Width: 1600 Screen Color: | [l
-
Screen Height: 1000 . v “
Screen Position: |{ [iJ 3
Full Screen Update Ao l4

[C) Corner Pin  Corners

Toggle Output

Display at Top Most Window Layer

Select this box to keep the ProPresenter output above any other windows on your output
screen. Disable this box if you need to show a full-screen video using the Web browser, or you
need to show a PowerPoint or Keynote presentation.

Scale to Fit Output Display
This will scale your presentation to the output resolution if they don’t match.

Enable Stage Display
This will enable the stage display on the indicated screen. You can also enable the Stage Display
screen by pressing Command-2 on your keyboard.

Configure Stage Display
This will bring up the stage display layout editor. This is covered in more detail later in this guide
in the section called Stage Display.

The Output (Out) and Stage Display (SD) outputs can be set within the Display preferences by
clicking and dragging the displays to the right positions. Note that you are only moving the

© 2005-2012 Renewed Vision, Inc. Page 12 of 131
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screen indicators in ProPresenter. The physical arrangement of the screens can only be changed
in System Preferences.

Edit System Display settings
This will open the Display settings available in System Preferences that were covered earlier in
this guide.

Output Screen
Clicking Full Screen will automatically use the resolution you set in Display preferences. If you
need to use a custom size, enter the resolution and click Update.

Corner Pinning
This allows you to make adjustments to the display output and will be covered later in this user
guide.

Screen Color
This specifies the default slide background color. This is the color you will see on your
thumbnails and if no other background is selected. You can use any color.

Screen Position
This allows you to designate which part of the screen your presentation will be anchored to if
the presentation dimensions are smaller than the actual output resolution.

Toggle Output

This turns your primary output on and off. This can also be done by pressing Command-1 on
your keyboard.

© 2005-2012 Renewed Vision, Inc. Page 13 of 131
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Corner Pinning

In ProPresenter 5 we have included the ability to use corner pinning on the output from the
program. This will allow you to make modifications to the output shape when keystoning isn’t
quite enough, or you’re projecting onto a surface with angled sides.

From the Display preference tab, enable Corner Pinning by checking the box next to it. Click on
the Corners button to open the settings. The settings default to a perfect square using your
Output Screen resolution.

"0 S Display
2 ] (=] v P
[=5] ¢ | &
Ceneral | Display | Label DVD Live Sync Network Advanced Modules
X Y
Outpu F
ToplLeft
v p 0 0
(s TopRight 640 0
— ' BottomLeft 0 480 play
BottomRight 640 480

v/—\\
[ Cancel ) ( OK )

Edit System Display settings

Output Screen

Screen Width: 640 Screen Color: | []
VN

Screen Height: 480 L N
Screen Position: | @ )
A — 4

Full Screen Update

g Corner Pin | Corners

Toggle Output
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The images below shows what changes to each value does to the actual output. For this
illustration, the output screen has been set to 640x480. The left image shows the initial screen
settings and the second shows the adjusted output settings. Each setting is represented
individually by the eight thumbnails below. The default slide color is set to Cyan to make it
easier to see the results of the corner pinning. The eight thumbnails are arranged in the same
order as the pinning values.

X Y X Y
TopLeft | 0 | 0 Topleft 100 1po
TopRight 640 0 TopRight 540 100
BottomLeft 0 480 BottomLeft 100 380
BottomRight 640 480 BottomRight 540 380
(W) (T) ( Cancel ) ( OK )

WEEISEN,
vast'as therocean

herelis!\o;
here IS0,
Vast as ther

eS|
vast asithelocean

N -
vast asithelocean
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Label

() O Label

A i|§E| 2 %@ &, 208 N

General Display Label DVD Live Sync Network Advanced Modules

Library Categories

Category o
Song

Presentation

Bible

Speaker Notes

PowerPoint

Group & Slide Labels

Group Color | 4 Slide Color | 4
Verse 1 H - Blank Slide -
Verse 2 | ~ Instrumental m ~
Verse 3 | ~ Repeat -
Chorus H ~ Spoken Word | ~

Library Categories

You can use Categories in the Library to help sort your presentation. Labels are set when
creating a new presentation, but can be changed at any time. Use this section to create
additional categories that you might need. To delete a category, select it and press the Delete
key on your keyboard.

Group & Slide Labels

Group labels are used with the Grouping and Arrangements feature that is covered later in this
user guide. Slide groups work like stanzas and allow you to keep sets of slides together to easily
arrange them.

Within each group you can designate more specific labels on individual slides if you need to. To
add these labels, open the Editor, go to the Slide Properties tab, and assign the label. Slide labels
will still exist within a slide group. You can see groups for Verse 1 and Verse 2 in the image
below as well as an Instrumental slide within Verse 1.

1. Verse 1 X ] 4. Verse 2 5.
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DVD

e MO

BELE-= 1%%@;' ™ 9% -

Ceneral Display Label Live  Sync Network Advanced Modules

DVD Settings
__| Disable DVD playback feature

__| Prevent DVD spin down

HandBrake

HandBrakeCLI allows ProPresenter to save DVD clips to your
hard drive. Note that this is different from the regular GUI
version of HandBrake.

Install HandBrakeCLI

Disable DVD playback feature Selecting this option will prevent DVDs from being played in
ProPresenter.

Prevent DVD spin down Selecting this option will keep the DVD spinning so that there is less
delay when you click on a selected DVD clip. It's recommended to keep this option checked.

Install HandBrakeCLI This is a new feature in ProPresenter 5. If you frequently use DVDs and
would like the ability to rip clips to your computer instead of playing them directly back from the

DVD, install this component.

We also recommend installing VLC (it’s free) to expand the DVDs that this feature can be used
with. Ripping DVDs will be covered later in this user guide.
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Live

ProPresenter supports a live video feed over FireWire, SDI, or USB input. While this feature is
convenient, it does have some drawbacks like latency (delay) when using FireWire. It's best
suited for overflow rooms or small services where you may have a single camera and cost is
more important than latency. It's not recommended for larger, multi-camera venues that are
served best by a multi-port switcher.

OO Live

o] = o BRI B ok -

General Display Label DVD @ Live Sync Network Advanced Modules

Live Video Settings

“»

Video Source: | Built-in iSight
[} Audio Source: Built-in Input

[Z] Preserve Aspect Ratio

| Disable Video Input

Video Source
Select the input device for your video source. This can be the iSight camera, an external camera
source, or a software “camera” like CamTwist or ManyCams.

Audio Source
Select the audio source (if needed) to be used with your camera.

Preserve Aspect Ratio
This prevents your camera input from being stretched full-screen if your output resolution and

the camera resolution don’t match.

Disable Video Input
This prevents the Live button in the toolbar (or F7) from sending a camera signal to your output.
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Sync

ProPresenter 5 makes it easy to sync files between computers, including files other than just
your Library. This makes it much easier to setup a new computer with ProPresenter as well as
being able to keep computers in sync with each other.

®No Sync

(o] ) E= o) % )0

General Display Label DVD Live = Sync

e

Network Advanced Modules

Synchronize Library

Server

Source: +

Path to currently mounted drive on Desktop
Include in Sync Service:
El Library Documents
[ Playlists, Props Messages & Masks
[ Templates
[ Media

@ Sync files down
~

() Sync files up

() Bidirectional sync

["] Replace My Files Sync Files

We introduced Sync in ProPresenter 4, but it could only sync Library files. In ProPresenter 5 we
have added the ability to sync all of your files to a central folder in order keep multiple
computers matched up.

The diagram below shows you the basic idea of how Sync works now. Before you can even begin
syncing, you will need to have a central folder for everything to be stored. This folder cannot be
the same as your library folder used by ProPresenter since it is going to be used to facilitate your
files for syncing.

Once you have your central folder in place, use the “Sync files up” option on Mac 1 to create the
necessary sync folders and to copy the data. You will have up to five folders in your sync folder.
After the sync is complete, you can use any of the sync options. If you are setting up additional
computers to match the first one, you would select the central folder and choose “Sync files
down” to move the files to that computer. In the future you would probably use “Bidirectional

sync”.
Step I: .
Sync Up to a central folder
l e » 1
Step 2: Step 2:

Yy

Sync Up/Down/Bidirectional — Sync Up/Down/Bidirectional
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Sync files down
This will move files from the Source to your computer.

Sync files up
This will move files from your computer to the Source.

Bidirectional sync

This will look for differences between your computer and the Source and sync those files. If a
newer version of a file is detected, you will be shown a prompt alerting you that the older
version is being replaced.

Replace My Files/Replace Files on Server

This will replace the files in the destination folder regardless of the timestamp on files. This
option isn’t available on Bidirectional sync.

© 2005-2012 Renewed Vision, Inc. Page 20 of 131



Network

(&) (&) Network

oV mEE L %0

GCeneral Display Label DVD Live Sync

ProPresenter 5 for Mac User Manual

87 o~
e RO

Network Advanced Modules

Master Control

| Off + | Name: .
ProPresenter Remote Server
_ Enable __ Controller
__| Observer

Remote Stage Display Server Settings
__ Enable

PVP Network
__ Receive Network Commands
Network Name: >ProPresenter5

Planning Center Online
Check for Plan Updates
Upload Documents
@ Match Songs in Library
__ Show Historical Service Plans

Port:

Password: control

Password: observe

Password: password

Port: Opt

Port: 45688 | Edit

O Auto ) Manual
O) Auto ) Manual

Login User: Not logged ir

Organization: Not logged i

Master Control Slave
This is a new feature in ProPresenter 5. It will be covered in more detail later in this user manual
in Master Control Module section.

ProPresenter Remote Server Settings
This section of Network preferences enables the iOS ProPresenter Remote app. Check Enable
and then either (or both) Controller or Observer and set new passwords for each. If your

computer and iOS device are on the same network, you can connect to ProPresenter and use
the remote to control playlists or to follow along.

You may need to disable your computer’s firewall if you have connection issues. Open System
Preferences, go to Security. Click on the Firewall tab and click on Stop to turn off the firewall.

Remote Stage Display Server Settings
Enabling this setting will allow you to use the iOS ProPresenter Stage Display app. This allows
you to use any iOS device as a wireless stage display. Set a new password for this. If you are on a

© 2005-2012 Renewed Vision, Inc.
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very restricted network, as your network administrator for a port that you can use if you can’t
connect.

PVP Network Settings

If you are using ProVideoPlayer, you can control the videos that are loaded in ProPresenter
simultaneously. Enable Receive Network Commands for this to work. In PVP, open
Preferences>Network and make sure this computer is showing up as being connected.

If you want to be able to control the visual properties of the videos, check the Enable Visual
Adjustments option.

You will need to configure your playlists in ProPresenter’s Video/Image Bin to match the ones in
PVP for this to work properly. Commands are sent based on the order of playlists and the
position of the clip, not based on names. If you use any folders to sort your media in
ProPresenter, move those below the playlists you want PVP to control.

PVP Network settings will be included for all uses with ProPresenter 5 and is no longer part of
the Advanced Module.

Planning Center Online

This is a new feature in ProPresenter 5 and will be covered in more detail later in this user
manual in the section all Planning Center Online. The settings listed here allow you to control the
basic behavior of the PCO integration.

Changes made to a PCO service order online can automatically be detected by ProPresenter, and
documents added in ProPresenter to a PCO playlist can be uploaded to the service element

online for future use.

If you check the option to Show Historical Service Plans then past services will also be available
to you. Otherwise, only plans from the current date and later will be available.

You can log in or log out of Planning Center Online from here as well.
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Advanced
(AN Advanced
- E— ~_
g— ) (@D >
o W= LD O e
General Dlsplay Label Live  Sync Network Advanced Modules

Import Video/Image Scale Behavior

Background: | Stretch to Fill *| Foreground: | Scale to Fit

Video Playback
__ High Quality __! Deinterlace __| Play Every Frame

Rendered Output Behavior

__| Render Output as Anamorphic __| Turn off Preview

The image above shows the default view of the Advanced preferences. If you enable the Alpha
Key or SDI Output module, additional settings are shown at the bottom of this screen. Those will
be covered later in this user guide.

Import Video/Image Scale Behavior

These settings affect how backgrounds and foregrounds are formatted when you import them
into ProPresenter. Generally you will want to set Background to Stretch to Fill so that
backgrounds fill your entire screen. Foreground will usually be Scale to Fit so that the aspect
ratio of the video remains the same when displayed on your screens.

Video Playback

These settings are usually left unchecked. High Quality can be used if you are showing videos
that have small-point text embedded in the video. Deinterlace and Play Every Frame are only
needed if you are using files that are encoded using a DV codec.

Render Output Behavior

These settings are used for troubleshooting rather than general performance. Render Output as
Anamorphic allows you to use 16x9 content in a 4x3 environment without distorting the original
video. Turn off Preview disables the preview screen in ProPresenter.
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Modules
®NoO Modules
e E— > IV,
Ea% A
0] = 0, w S OR P
General Display Label DVD Live Sync Network Advanced Modules
Modules
New Module Code: +
ID Code:
Alpha Key
(Buy) Q 9 Key and Fill HD/SDI output designed for Blackmagic
Video Cards

Edge Blending
(Buy] |E An Extension to Multi-Screen that allows a seemless
blend between two or three projector screens

"\ Master Control

(Buy ﬂ Master control of other ProPresenter Computers over
the network

Multi-Screen

L]
(Buy) ;"J*fﬁ Multiple Screen Options designed for Matrox Dual &
== Triple Head-2-Go
. SDI Output
(Buy | ‘g"‘ | Sends the output through SDI. Designed for
- Blackmagic Video Cards
@ Demo Modules

The Modules tab is new in ProPresenter 5. We have relocated this function from the
Registration menu. We’ve also made it possible to demo any of the modules before you buy
them.

Note: Demo modules add a watermark to the output screen while in use and are also
reset when you restart ProPresenter. The Master Control module has a 10 minute
time limit.

New Module Code

If you have purchased a module, enter the 25-digit code here and then click the + to activate the
module. After you have activated a module, the blue “Buy” button will change to a green check
mark. When ProPresenter is registered, an ID Code will be shown as well. This is needed to
purchase a module and link it to a specific computer.

Demo Modules

If you click this button, all the modules will be enabled in demo mode for the current session of
ProPresenter. You will have the full functionality of the modules, but the ProPresenter
watermark will be placed on the output screen. When you close ProPresenter, the modules will
be turned off again.

Purchased modules will have a green check next to them instead of the blue “Buy” button.

Each module will be covered in more detail later in this user manual.
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Toolbar

If you are familiar with ProPresenter 4 you will notice that several of the icons in the default
toolbar have been changed, some new ones are there, and others aren’t there. This section
covers all the default icons first, and then explains the remaining icons that can be added to the
toolbar through the Customize Toolbar option.

Clear All

This removes everything that is active in ProPresenter: slides, videos, pictures, audio, websites,
etc. When you click this button it will clear the screen and show your default slide color that is
set in Preferences. This also stops timed presentations or the Timeline.

Slides

This will remove anything that is part of the slide layer. Normally this is just text, but may also
have pictures on a slide, or other slide objects. Clearing slides will keep the background showing
and allow audio files to continue playing. If you are using a timed presentation or a Timeline,
these will continue and the next slide that is triggered will be displayed.

Backgrounds

This will clear the background, still image or video, from the screen but everything else will
continue. When you clear the background from a presentation, the default slide color will be
used instead until a new background is selected.

Tip: If you want to select a slide that has a background linked to it, but don’t want to
use that background at the time, press the Option key to temporarily remove the
backgrounds from the presentation while you select the slide. Release the Option key
and the backgrounds will be shown again.

Logo
This button will show the default logo that you have set in Preferences. This functions the same
as a Clear command and removes all other content from the screen.

New
This creates a new Library document. You will be able to select the Template and Category of
the presentation before adding it to your Library.

Editor
When a Library presentation is selected, you can use this button to open the presentation in the
Editor to make changes.

Video/Image
This opens the Video/Image Bin below the Slide Viewer. The Video/Image Bin is used to organize
your media files in ProPresenter.

Audio

This opens the Audio bin to the right of the Slide Viewer. The Audio Bin can be used to play
audio files for walk in music, sound effects for plays, or whenever you want to play music from
ProPresenter.
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Messages
This opens the Messages module. Messages include any on-screen announcement you need to
make, like a child number, or countdown clocks shown to the audience.

Store

This opens to our media store, which is powered by Worship House Media. You can download
the free media samples through the store, or you can purchase new media for your
organization.

Song Select
This will open to CCLI’s SongSelect service. This is a subscription service and is not part of
Renewed Vision. We only provide access to this service.

Bibles

This will open the Bibles module in ProPresenter. You can access any installed translation or add
new translations at any time. Bible searches can be turned into new presentations, added to the
currently selected presentation, or shown directly from here.

DVD
This opens the DVD module. You can create clips from a DVD and add them to a presentation or
playlist, shown a DVD segment directly from here, or rip a DVD clip into a file on your computer.

Note: Newer Mac minis and all MacBook Airs don’t have a built-in DVD player. You
will need an external optical drive to use this feature. Multiple optical drives are not
supported.

Twitter
This opens the Twitter module, allowing you to show a stream of tweets directly within
ProPresenter. This is covered in more detail later in this user guide.

Format
This opens the in-line formatting toolbar that allows you to make fast formatting changes to the
font style of your slides from within the Slide Viewer instead of having to open the Editor.

Timeline
This opens the Timeline interface for a song. Creating a timeline is covered in more detail later in
the user guide.

Template

You can change the template for the active presentation from this button. You're also able to
change the template for an individual slide or multiple presentation at once depending on the
selections that are made.

Note: This functions differently than it did in ProPresenter 4. Instead of applying to
newly create slides or presentations, this actually changes the template right away.

Output
This button toggles the primary output on and off.
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Volume
This controls the output volume of ProPresenter. If your computer volume is turned up and you
still don’t hear anything from ProPresenter, make sure this hasn’t been muted.

Customize
This button is a shortcut to the Customize Toolbar window where you can add and remove, or
re-arrange, the toolbar icons.

ProPresenter logo
The ProPresenter logo button opens the Info Center where you can find links to helpful
resources.

The following options are available through the Customize Toolbar option. To add or remove
icons, open the Customize Toolbar window and drag icons on and off the toolbar. To re-arrange
icons, just drag them to the new location on the toolbar.

Drag your favorite items into the toolbar.

o | -
® ha & % &
Separator Space Clear Al Clear Backgrounds Clear Slide Clear Props. Clear Audio
- @
(- - VA (. /]
Co to Logo New Document Template Presenter/Editor Video/Image Bin Audio Bin Messages/Timers
3
Props Clocks Information Center Bibles DVD Player Live Video Web Browser
Media Browser Stage Display Message Online Store Online Song Select Twitter Phone Mask
i L4 B - - A
= ] “
Show Output Volume Show Format Bar Show Timeline Flexible Space Customize
or drag the default set into the toolbar.
— - -
B =
Xkl ma @ L E2000 & =
Clear All Slides BKGs Logo New  Editor Video/Image Audio Messages Store SongSelect Bibles DVD  Twitter Format Timefine Template Output
Show | Iconand Text 1] ™ Use small size ( Done )

Separator
You can added this vertical dashed line to help divide your toolbar into sections that make more
sense for you.

Space
This is an invisible element in the toolbar, but functions the same as a Separator.

Clear Props

Props include any image or video you have playing above everything else on screen as well as
items shown using the Messages module. Using Messages will be covered later in this user
guide. Additional ways to clear Props will also be covered later in this guide.

Clear Audio
This will clear any audio file that is selected from the Audio Bin or audio file that is added

directly to a presentation or the Timeline. This does not clear audio that is embedded in a video
file.

Props
Props are any element that you want to keep on screen above other elements. This is commonly
used for things like logo bugs in the corner of the screen. A “logo bug” is similar to what TV
stations display in the lower right corner during shows.
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Clocks
Any clock that is started from here will only show up on the Stage Display.

Information Center
This gives you quick access to the Information Center page.

Live Video
This will enable your selected camera input that you set in Preferences.

Web Browser
This opens the built-in web browser, allowing you to show entire websites seamlessly from
within ProPresenter.

Media Browser
This opens the Media Browser. The Media Browser will be covered in more detail later in this
user guide.

Stage Display Message
This will open a message window that sends a message to just the Stage Display if it is enabled
in the Stage Display layout.

iPhone
This toolbar item gives you a quick on and off switch for the iOS remote app. If you have the
Network settings properly configured for the remote, this will enable and disable the settings.

Mask

The Mask layer is another layer available in presentations. Since most users probably don’t need
this feature, we don’t include it in the default toolbar. The Mask layer will be covered in more
detail later in this user guide.

Flexible Space

This is similar to “Space”, but it grows and shrinks depending on the size of the ProPresenter
window.
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Copyright Settings

ProPresenter makes it easy to display copyright information for songs. When you import a song
from SongSelect, the data is automatically filled in. If you create your own song files, you can
manually enter the copyright information if you want to.

There are two places that you need to configure copyright display. The first place is in
Preferences at the bottom of the General tab. These are the global settings that apply to every
presentation in the library. As you can see, you can choose to show the copyright information on
the first, last, first and last, or every slide of your presentation.

The License # box on the right is for you to enter your church’s unique license number. You will
need to contact CCLI for this number if you aren’t sure what it is.

®No General

) EE LB ® 2 [H g o

General Dis?iay Label DVD Live Sync Network MultiScreen Blend Advanced Modules

Ceneral Settings
@ Check for updates at startup Check for update

a
v

Library Folder: | Default

Default Logo:
ﬂ M Preserve aspect ratio
v

Application Data
@ For All Users () Only this User () Custom Path

Media Repository
@ For All Users () Only this User () Custom Path

__ Manage Media Automatically
Search Paths:
~/Movies +
~/Pictures
~/Renewed Vision Media

Copyright
IZ' Enable Copyright display License #: 12345678
@ First Slide () Last Slide Configure CCLI Layout...
() First & Last () All Slides Reporting...

Reset All Preferences

To change the copyright elements that are shown (Title, Artist, publishing information, etc.) click
on the Configure CCLI Layout... button. This will open the options shown below.

Each of the copyright elements are controlled by “Tokens”, a feature in ProPresenter that allows
text from one part of the program to be automatically shown by a different feature. The tokens
on the left are the active tokens, meaning these are the ones that will be shown. The column on
the right shows all of the options available. You can add and remove tokens from the left
column by clicking and dragging them in and out of the right column.

© 2005-2012 Renewed Vision, Inc. Page 29 of 131



ProPresenter 5 for Mac User Manual

Note: The copyright symbol is not included as a token, so if you accidentally delete it
you can use Command-G on your keyboard to type it again.

= % e
N o g
General | Display Label DVD Live Sync Network Advanced Modules

Copyright Format:
Gen Title
v Artist
1 Publisher @
Li Copyright Year
License Number

te

ar

C

Edit Template Done
Med

) For All Users " Only this User _ Custom Path

7

_ ! Manage Media Automatically

Search Paths:

~/Movies i
~/Pictures
~/Renewed Vision Media

Copyright
V! Enable Copyright display License #:

* First Slide () Last Slide Configure CCLI Layout...

") First & Last () All Slides Reporting...

Reset All Preferences

Clicking on Edit Template will open the Template Editor and allow you to format the position
and text settings for your copyright information. Since tokens aren’t actually text, the only thing
you'll see in the text box is the copyright symbol. If you want to see how text will look
formatted, add any text you want since this will be replaced automatically.

) Herels Love N '
B icre |s Love Chord Chant Last Used: 11/5/11
Artist Display Copyright V! [ ] d: -
Author:  Matt Redman, William Rees, Robert S. Lowry Song #: 3287884 080_:
Publisher: . Thankyou Music (Admin. by EMI Christian Music Publishing) ©Year: 2004 v

L]

Once you have configured how you want your copyright information to be displayed, you will
need to make sure a presentation has information to display and that it’s enabled. If you have
imported a song from SongSelect, this information is filled in automatically and Display
Copyright is checked by default.
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To access the copyright information, click on the blue info button next to the presentation title
at the top of the slide viewer. If this data isn’t already filled in, you can fill in as much as you
know. If you need to change whether or not the copyright information is shown for a specific
presentation, check or uncheck the Display Copyright box

This information is used by the tokens that you enabled in the previous section. If you include a
token but there is no information in that text field, nothing will be shown on the slide(s) that the
copyright information is displayed on.

Note: The Title entered here can be different than the name of the presentation in the
Library. If you want to have multiple copies of a presentation, but show the correct copyright
information for each presentation, just change the name of the presentation in the library

and leave this as is.

The rest of this panel is covered later in this user guide.
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Created Title Author Publisher

All My Fountains Chris Tomlin...

CCLI #
5925670

Copyright

Hillsong Music Publishing (A...

10/1/11 From The Insi... Joel Houston 2005 4705176
10/1/11 Your Grace Is ... Matt Maher spiritandsong.com | Thanky... 2003 4477026
10/1/11 Everlasting God Brenton Bro... Thankyou Music (Admin. by ... 2005 4556538
‘/_\ f—\
Reset Export

One feature we have been asked for over and over again is the ability to generate a CCLI report.
In ProPresenter 5 we make it easy to generate a report of all the new songs you’ve added to
your library. CCLI only requires that you report when you add a song to your library, not how

many times you use the song.

To access this, open Preferences, go to the General tab, and click on the Reporting... button at

the bottom.

You can reset this list to make it easy for you to track your songs during each reporting period.
You can also export the list as a text file if you want to keep a backup copy of this list for your

records.
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Presentation Layers

ProPresenter 5 presentations are composed of up to six layers.

Mask Layer

Have you ever wanted to project onto something that wasn’t a projector screen? Did you use
tape and cardboard to block out your project’s light to fit that shape? We introduced the Mask
Layer in ProPresenter 4 to solve that problem. Instead of placing things in front of your
projectors, you can draw a Mask in ProPresenter, or using Photoshop to create custom
projection areas. Once enabled, a Mask will automatically activate when ProPresenter opens.
Masks can only be enabled and disabled from the Mask module. You will need to customize
your toolbar to add the Mask module button.

Props Layer

Props are items that sit on the topmost-layer of your visible output (not visible over a Mask).
The most common Prop type is a logo “bug.” This is a small graphic that is usually shown in the
lower right corner of the screen at all times. This is the same thing as a cable channel logo that is
shown on TV. Messages and Countdowns are also shown in the Props layer, in addition to actual
Prop.

Slide Layer

Slides are the most fundamental element of ProPresenter and exist within Library presentations.
They contain the bulk of the information most users will be displaying. The slide layer may
contain ext slides, announcement loops, slideshows or any other pre-formatted text and/or
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graphic slides. We have continued building upon this layer in ProPresenter 5, adding several new
features that will be covered later in this user guide.

Video Playback
This layer is used for any full-screen video or image playback. There are two variations on this
layer: Backgrounds and Foregrounds.

¢ Backgrounds are videos or graphics played underneath the Slide Layer. They persist across
multiple slides and continue to display until cleared or another background is triggered.
Background videos are automatically set to loop, but this can be changed in the settings for
each file in Media Properties. Backgrounds can be assigned directly to slides or selected from
the Video/Image Bin.

¢ Foregrounds are generally any video or image that you would notate on a cue sheet, such as
sermon illustration videos, announcement videos, or any other video or image that is intended
to be shown by itself. They will clear the output when triggered and be cleared when another
slide is triggered. Foreground videos are set to play just once, but this can be changed in the
Media Properties for each file. They can be added directly to presentations, Playlists, or played
directly from the Video/Image Bin.

Live Video

The Live Video function in ProPresenter takes a live camera feed from any QuickTime-
compatible video interface and shows it full screen underneath the other layers mentioned
above. If a background is active, you will need to clear the background in order to see the Live
Video source.

Background Color

This is the default color you want to show when absolutely nothing else is shown on the screen
(by default this is set to black). In addition to the default global screen color defined in
Preferences, a default background color can be defined for each presentation as well as
individual slides within a presentation.
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Working with Templates

Templates allow you to quickly reformat a song to a new layout, or to change an entire set of
songs. If you're familiar with ProPresenter 4 you'll quickly realize some things have changed with
how Templates are selected and applied. Templates also support some new slide features, but
those will be covered later in this user guide in different sections.

When you create a new presentation, you select the Template every time. Instead of choosing
the Template from a different menu, we have merged Templates into the new document menu.
Unless you need to change this, once you select the Template the first time, it will continue
being used for all new songs.

New File Name: Untitled
File Options

Category: Presentation =
Template:
Size: 1920 x 1080 :

v

Cancel ) [ New

In the same fashion, we have made a similar change to how new slides are created in a
presentation. There are two options for creating new slides in a presentation. In the image
below, you can see a plus sign and a down arrow. If you select the plus (+) button, it will create a
new slide using the last used template from this menu. If you click the down arrow you will see a
list of Templates. Selecting a template will create a slide with those properties. This will also
become the Template used when clicking the plus button in that presentation.
_J ]

11. Verse 2 12, Verse 2
|
BB

Video/Image Bin

i Backgrounds

#4 Foregrounds
T SO Ry

Sort By Index = Search

. ClNC,

Finally, we have changed how you apply a Template to an existing, or set of
existing, presentations. In ProPresenter 4, you had to click on the Format
& -

[ |

button, then Templates. In ProPresenter 5 we’ve moved this button to the
toolbar (don’t confuse this with the Templates toolbar button in ProPresenter
4). Choosing a Template from here will update the selected slide, presentation,
or set of presentations.

Template
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Working with Media

Video/Image Bin

The Video/Image Bin is the best location for managing your media within ProPresenter. In
ProPresenter 5 we have added a couple of new features that now make the Video/Image Bin
even more useful for you.

To access the Video/Image Bin, click on the Video/Image icon in the toolbar. You can also press
Control-V or open it from the View menu. Once the bin is open, you will find it below the slide
viewer. The first time you open this, it will be empty, but once you have started adding content
it will begin to look like the image below.

Video/Image Bin
ckground

) Fall images

[# Clouds

[#] Abstracts

i Holidays
B Thanksgiving
B Christmas

Video/Image Bin The left section of the Video/Image Bin is used to maintain your playlists
'/ Backgrounds | and help you organize your content. The top three bins--Backgrounds,
i Foregrounds Foregrounds, and Purchased--are the default bins and can’t be renamed,
::ITI'::;:S moved or deleted. These three bins are your initial organizational tools for
B Clouds your media. To add playlists or folders, click the action menu in the lower-
[8] Abstracts left corner of the Video/Image Bin playlist column. You can resize or hide

v Ml Holidays the playlist column using the vertical handle bars in the lower-right corner

Thanksgiving

h of the playlist column.
ristmas

Backgrounds are automatically set to loop while they play, Foregrounds
are automatically set to play just once, and anything you download

through the in-app Store is added to Purchased and automatically set as a
background or foreground depending on the type of media. When you

download the free media bundle, it will be added to the Purchased folder.

You can further organize your content into playlists. Playlists in the Video/Image Bin work
similar to those in the Library in that you can add content from your main bins into the playlist
without removing them from the main bins. You can also add media directly from the Finder
into a playlist. When you do this, the file will also appear in your Backgrounds bin.

If you need to organize your playlists further you can create a new Group Folder (black folder
icon). Folders are used to organize playlists, so if you created a folder called “Holidays” like the
one shown above, you can then add playlists to that folder for each holiday. Folders are really
useful to organize playlists of special purpose media like this. Media cannot be added directly to
a folder.

The new feature in the Video/Image Bin is the Hot Folder. Hot Folders are used to link directly to
a folder on your computer. Any time you add or remove media from that folder, those changes
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will be reflected in the Hot Folder. Media cannot be added to a Hot Folder from within
ProPresenter. Hot Folders are useful if you have a temporary work folder that you’re constantly
updating. Since the Hot Folder will watch for changes, you can move files in and out of that
folder as much as you need to. Media in a Hot Folder is not included in the Backgrounds or
Foregrounds bins.

To add media to your Video/Image Bin you can use any of three different options. The fastest
way to add media is to open the folder containing the media in the Finder and drag the files into
the Video/Image Bin where you want them located. The other options are to click on the plus
button on the bottom of the bin or by going to File>Import>Import Video/Image and locating
the media in the Finder window that opens. Using the latter option will import the media to the
selected bin or playlist in the Video/Image Bin.

If you want to change the sort order of your media, click on the Sort By drop-down menu at the
top of the Video/Image Bin. There are a number of options that you can use to sort your media.
If you are looking for files with specific words in the file name, type that in the Search box to
search the current bin or playlist.

In addition to the new playlist options in ProPresenter 5, we’ve also added the option to use
different transition effects for media. In earlier versions of ProPresenter, the only options you
had were either a cut or dissolve transition.

- ‘a‘ B o (m o (= ,c‘ i) o &

\

s O HBIES ) b ®)s
Mod Swap

-

Dissolve Ripple Flip Cube Door

0
Duration:

Bae -«

b.
am

To access these new transition options, click on the transitions button in the lower-left corner of
the Video/Image Bin. Select the transition you want your media to use and set the duration,
then click Done.

The icons in the lower-right corner and the slider allow you to toggle between a thumbnail and a
list view of your media and to change the size of the thumbnails.

If you see thumbnails with a question mark on top of them it means the file path to that media
file has changed. Either relink the file, or remove it from the Video/Image Bin.
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Media Browser

e 00 Media
Images Audio Movies Links

FOLDERS
(] Pictures
(] Desktop Pictures

[_]iChat Icons
(] User Pictures
(] Animals
D.-‘.;.-;:.‘:
Name Size
“ Dahlia 48x48
“ Flower 48x48
“ Red Rose 48x48
“ Sunflower 48x48
€ Tulip 48x48
“ Whiterose 48x48
“ Yellow Daisy 48x48
T = O 7 images Q

To access the Media Browser, click on View and then select Media Browser. You can also
customize your toolbar and add a button or press Control-K on your keyboard to open it.

The Media Browser gives you another option for accessing your media files. If you have use
iMovie you may be familiar with this interface since it is similar to the media browser in that
program. Media is automatically categorized in Images, Audio, Movies, and Links, making it easy
for you to quickly find what you’re looking for.

To use content from the Media Browser, click and drag it to the slide that you want it applied to.
Images, Audio, and Movies can only be added to presentation; you cannot use the Media
Browser to add content to your Video/Image Bin. Links pull the bookmarks from Safari and can
then be added to a playlist and will open the Web Browser when selected.
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Media Properties

In ProPresenter 4 we added the ability to adjust the color properties of videos and images, as
well as the ability to change the speed of videos. Now you have even more options to make your
media library even more dynamic.

Any image or video can be adjusted using the following settings, but these must be set before
using the clip since the effects aren’t applied in real-time. The benefit of using these effects
within ProPresenter is that you can use the same clip on your hard drive multiple times with
different looks. Before, if you wanted five different looks on the same clip, you would have had
to render five different files; now you just create five references to the same file.

To access the Media Cue Inspector, right-click on a thumbnail in the Video/Image Bin, or on a
thumbnail in a presentation, and choose Properties. This will open the window shown below.

Media Cue Inspector

0 * Hi

Label:
’_ intheclouds04_480p_mov.mov |

Info:

Size: 640 x 480
Duration: 0:00:00:30.03
Data Size: 11.02 MB
Data Rate: 3.08 Mb/s
FPS: 29.97

Format: H264, 640 x 480,
Millions

00:00:00 » 00:00:30

in ] [0:00:00:0000| 4« << > PP PP [0:00:00:30.03 [Our] .

Set Thumbnail Reset In/Out |

@ ...op/Pro5 Media/Centerline New Media/intheclouds04_480p_mov.mov

From this window, you can adjust the In and Out points for any video file. If you have a longer
video and only want to show part of it, this is where you can make those changes without
having to edit the original video. If you need to change the thumbnail or remove the custom in
and out points, use the two buttons below the playback controls.

If you need to locate this file on your computer, click on the magnifying glass icon next to the file
path.

On the right side of this window, the buttons at the top switch between basic information tab
(shown), the Properties tab, and the Effects tab.

The Label will use the file name by default, but as you can see with the video that’s open, the file
name doesn’t necessarily make a lot of sense. You can change the Label to something that
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makes more sense for you and it will then be shown below the thumbnail in the Video/Image
Bin.

The Info section shows you details about the video or image file.

If you want to set a custom transition for the media file, you can change that here as well. These
effects will actually be available in the Video/Image Bin and in a presentation once set.

The second tab in the Media Cue Inspector is the Properties tab. These settings can be used to
change the way a file is scaled, where it’s positioned on screen, and the orientation of the file. If
you are working with a video, you can also change the volume of the audio track, the play rate
(speed) of the video and whether the video loops or stops when it reaches the end of the file.
There is also an option called “palindrome” for videos. When the video reaches the end of the
file, it will play in reverse.

Media Cue Inspector

o *

Stretch to Fill 7

Flip Horizontally

Flip Vertically

Volume: «
Play Rate: «

Behavior:

00:00:00 » 00:00:30
[[in"| 0:00:00:00.00 |¢q <<« > P> »» [ 0:00:00:30.03 [Oul|

Set Thumbnail Reset In/Out

@ ...op/Pro5 Media/Centerline New Media/intheclouds04_480p_mov.mov
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In the image above, there are two arrows shown in the lower-right corner of the window. These
arrows are shown when you select multiple media cues and open all of them in the Inspector.
Clicking the arrows will switch to the next or previous file.

The third screen in the Cue Inspector is new in ProPresenter 5. From this screen, you can now
apply several new effects to your media.

Media Cue Inspector

o ¥

No Effect

Image Blur

] Edge Blur
Radius

Hue Saturation Contrast Brightness

00:00:00 » 00:00:30
In | 0:00:00:00.00 |44 <« > P> PP 0:00:00:30.03 | Oul

" ResetAll
Set Thumbnail Reset In/Out

@ ...op/Pro5 Media/Centerline New Media/intheclouds04_480p_mov.mov

When you first select the Effects tab, you can make a few basic changes.

Image Blur applies a blurring mask to the entire video or image. Moving the slider left and right
will change how much blurring is used.

Edge Blue applies a circular blurring mask from the outer edges. The the sliders change the
amount of blurring that is applied.

Hue, Saturation, Contrast, and Brightness change the basic look of the video or image.
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For even more variety, you can use different pre-built effects that are available. By default, this
will say “No Effect”, but if you click on the menu, you’ll see the five options shown below.

Media Cue Inspector

v No Effect
Color Filter
Sepia Tone
Color Invert
Cray Invert
Heat Signature

Hue Saturation Contrast Brightness

00:00:00 = 00:00:30

In | 0:00:00:0000 |44 <4 » P> »»  0:00:00:30.03 |Oul
Reset All

Set Thumbnail Reset In/Out

Q ...op/Pro5 Media/Centerline New Media/intheclouds04_480p_mov.mov

Color Filter: This is the only one of the new filters that have additional options. While the Hue
slider will change the color of the video, the Color Filter allows you to pick any color available to
change the color of your video or image. This makes it even easier to match the color of a video
or image to your lighting looks.

Media Cue Inspector

o & I

 Color Filter ) I:]

() Image Blur

(C) Edge Blur

Hue Saturation Contrast Brightness

I
- -

[ Reset All

00:00:00 »
["1n " | 0:00:00:00.00

Set Thumbnail |

@ ...op/Pro5 Media/Centerline New Media/inthecioudsU4_480p_mov.mov
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The remaining four effects are: Sepia Tone, Color Invert, Gray Invert, and Heat Signature. These
effects use pre-set values to change the color of the video or image. You can see the effect these

filters have on the same video in the image below.
o * i

(]
Sepia Tone - Color Invert
Image Blur
Edge Blur

Image Blur
Radius

Edge Blur
' Hue Saturation Contrast Brightness

Radius

Hoe Saturation Contrast Brightne
00:00:00 * 00:00:30
W | 000000000« << P> PP »p 003502000 [Ow
Reset All
Reset In/Out

Reset All
Set Thumbnail
© ...op/ProS Media/Centerline New Media/Intheckouds04_480p_mov.mov

W | 000000000 <« << P> P> »» 00850300 [Ow

Reset In/Out
L] * i

Set Thumbnall
© ..0p/ProS Media/Centerline New Media/Intheciouds04_480p_mov.mov
Heat Signature  ©

o

Image Blur

Edge Blur
Radius

Cray Invert

Image Blur
Edge Blur
Woe Saturation Contrast Brightne

Radius

Woe Saturation Contrast Brightness
00:00:00 + 00:00:30
w | 00000000 e <4 P P> >pi (003802000 (Ou
Reset All
Reset In/Out

00:00:30
Set Thumbnail

00:00:00 *

W | 000000000 < << P PP »» 008500000 Ow
Reset All

Reset In/Out

© ...cp/ProS Media/Centerline New Media/Intheckouds04_480p_mov.mov

Set Thumbnail
© ...op/ProS Media/Centerline New Media/Intheckouds04_480p_mov.mov
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Working with Presentations

Presentation File Formats

ProPresenter has three basic file types. These formats are cross compatible between the Mac
and Windows versions.

.pro5 -- This file extension is used on documents found in the Library. If you open up the folder
where your Library is stored, you will see files such as “Amazing Grace.pro5”.

.pro5x -- This file extension is used when you create a bundle. A bundle is a compressed folder
similar to a .zip folder. Bundles include presentation documents (.pro5) as well as any media
elements associated to the presentations or playlist selected. This can be a single presentation
or a playlist with bundled media.

.pro5plx -- This file extension is used when exporting a playlist without media files bundled with
the document files.

To import any of these three formats, simply double-click on the file on the computer you want

to open the file with and follow the prompts to add the content to the correct locations. You can
also go to File > Import >Import File to locate your file and import it.
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The Library in ProPresenter is your central storage location for all of your presentations. These
can be song documents, scripture presentations, speaker notes, announcement loops, or any
other custom presentation types.

You can locate any file in your Library using the search function at the top of the Library panel.
You can search by keywords in either the title or the contents of a presentation, and you can
further sort the results by their categories with the Filter drop-down menu.

Liprary 75 Found
Search: Q

Filter:| All Contents
TRE oo b [Cotegory [LastUsed
E O worship the King Céntemp... 12/25}01
m Onward Christian Soldiers Hymn 12/29/01

Clicking on a presentation name in the Library will immediately open that document in the slide
viewer and allow you to being using it immediately.

If you want to change the order that the results are sorted, click on either Title, Category, or Last
Used. If you want to remove any of the columns, right-click on one of the column titles and
uncheck the columns you don’t want to see.

To rename a presentation, right-click and choose Rename, or double-click the name to edit the
title. You can change the category of a presentation by right-clicking on the name and selecting
a new Category.

In addition to the Rename option, there are several other options available when you right-click
in the Library.

Library

75 Found

Search: Q
Filter:| All
Title
[]
[ onwarc
[ Ppraisey
D Rock of
D Sacred
D Sample
[ swing 1
[9 Take m
D The Fir
D The We
D To God
D Trusta

[N i Mmiim

: Contents

A Category

Reveal in Finder

Rename

Category >
Resize >
Reflow I
Duplicate

Delete

Print
Export Pro5 Bundle

e .
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Last Used

12/29/01
12/29/01
12/29/01
12/29/01

. 9/22/11

12/29/01
12/29/01
12/27/01

. 9/30/11

12/29/01

12/27/01 *
v

11111111

Reveal in Finder: Opens the file in the Finder.
Rename: Change the name of the presentation.
Category: Change the presentation category.
Resize: Change the size of one or more presentations.
Reflow: This will be covered later in this user guide.
Duplicate: Creates a duplicate copy of the
presentation.

Delete: Deletes the selected file.

Print: Opens the Print dialog.

Export Pro5 Bundle: This will be covered in more
detail later in this user guide.
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Adding new presentations

ProPresenter 5 makes some subtle but powerful changes to how new songs are created. When
you create a new presentation (File>New, Command-N, or clicking “New” in the toolbar), a
blank untitled presentation isn’t just added to the library anymore. Before a file is added to your
library, you can give it a title, select the template that will be used for the slides, and change the
category and size of the presentation if needed.

New File Name: Untitled
File Options

Category: Presentation :
Template:
Size: 1920 x 1080 =

v

Cancel ) ( New
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Beginning in ProPresenter 4 we supported multiple libraries. This makes it easy for multiple
organizations or groups to use the same computer without having to share library files or create

lots of alternate versions of files.

There are two ways to get started with multiple libraries. Open Preferences then click on the
General tab. Once you are here, click on the Library Folder drop-down menu and select Manage

Library.

en0e

0|

General

E_
@—
E_
Label

—_

Display

GCeneral

2 BO O o

Live Sync Network Advanced Modules

N

General Settings

W Check for updates at startup

Check for update

Library Folder: Default v
®eNeo General
Lol B HO O i
General Display Label DVD Live Sync Network Advanced Modules

Ceneral Settings

™ Check for updates at startup

Check for update

Library Folde v Default v
ProPresenter5

Default Logt

— w1

The second method is by clicking on the File menu, then selecting the Select Library menu and

then Manage Library.

2 & &)

8 =ix -

Clear All Slides  BKGs Logo

6 ProPresenter 5 ﬁ Edit Actions View Format Window Help

New #N L

Import > N
v Default [

ProPresenter5

Save All ®s

Save As... NEl ™ Manage Library...

Save Selected ! =

Revert to Saved

Save Selected Slides As Template...

Export Templates... sidryiandldesertiand|
tollfmyselllitcepwalking!

Reflow Presentation...

Export as Plain Text...

Export as Pro5 Bundle...
Export Playlist...
Print...

Use these same two locations to change the active Library at any time.
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After you have selected Manage Library using one of these methods, you will see the menu
shown below. This will show you the currently linked libraries. In this, there are two libraries:
one is called “Default” and the second is called “Youth group library.”

(&) General
o o e IS
a & e )
i — [ 22 ’ S.
General | Display Label DVD Live Sync Network Advanced Modules
Name Location
Default ~/Documents/ProPresenterS

+ || - ‘ Cancel ) € Save )

Media Repository

(*) For All Users () Only this User () Custom Path

sers/Shared /Renewed Vision M

[ Manage Media Automatically

Search Paths:

~/Movies ok
~/Pictures
~/Renewed Vision Media

Copyright
L/ Enable Copyright display License #:
() Eirst Slide () Last Slide Configure CCLI Layout...
(O First & Last () All Slides Reporting...

Reset All Preferences

To add additional libraries, click the add (+) button. This will open the Finder. Browse to where
you want to add the new library, create the folder and select it. It will be added to this list. If you
want to remove a linked library, select that library, then click the remove (-) button. This won’t
delete the folder, just the ProPresenter link to the folder.

It doesn’t really matter where you keep your folders or how you name them with the exception
of two locations.

The first location is directly in the main hard drive directory. The second place is inside your
default library folder. If the file path for the second library was “Macintosh HD/Youth group
library” or “/Users/chris/Documents/ProPresenter5/Youth group library”, then it should be
moved to a different location. Using either of these two locations can cause problems with your
Library. We recommend keeping your library stored on your computer to avoid any problems.
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Playlists

Immediately below the Library is the Playlist manager. Playlists are a way to create an outline of
your service or event with all the elements contained in a single list.

There are three different options available in this section: Playlists, Group Folders, and Planning
Center Online Playlists. Planning Center Online Playlists allow you to connect to your Planning
Center Online account and pull in the order of service directly into ProPresenter. This will be
covered in more detail later in this use guide. For now, we’ll focus on regular Playlists and
Folders.

| Contiguous |

\ “ 5 minute countdown

| Youth service [ Here Is Love
_- Old services D How Can | Keep From Si...
@] November 1, 2011 I"j Message notes

Ij Nothing But the Blood
[ Turn Your Eyes upon Jesus

[M New Document
E] New Playlist

i New Group Folder
[é] New PCO Playlist

&) ' M

To create a playlist, click on the action menu in the lower left corner and select the type of
playlist you want to create, or select to create a folder. The New Document option creates a
new file in the Library.

Note: Playlists are used to organize presentations and media. Group Folders are used to
organize your Playlists.

To add presentations from your Library or media from the Video/Image Bin, click on the item
and drag it into the playlist. You can also drag media files, PowerPoint, or Keynote files from the
Finder directly into a Playlist. PowerPoint and Keynote files in a Playlist will create a trigger to
launch the appropriate program for native-playback of the presentation.

If you double-click on a playlist or folder, you can rename it. If you want to move a playlist into a
Folder, drag the playlist name to the Folder and it will be moved into the Folder.

Normally when you click on an item in a playlist, it only shows that presentation or file.
However, if you click on the Contiguous button, everything in the playlist will be loaded into the
Slide Viewer for one continuous view of the playlist contents.

The button in the lower-right corner with the four arrows will resize the Playlist window and
hide the list of playlists on the left and the Library above, allowing you to see the Playlist easier.

To export a playlist, right-click on the playlist name and select Export Playlist. Choose the file
path and check the Include Media option if you want to export all of the associated media. You
can also drag the playlist name directly to another folder on your computer to automatically
export the playlist with all the media.
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Planning Center Online Playlist

One of the new features in ProPresenter 5 is the ability to create a playlist from your service
order in Planning Center Online (PCO).

Note: Planning Center Online is not a Renewed Vision product. You are required to have an
active Planning Center Online account to use this feature. You can find out more about

Planning Center online at http://get.planningcenteronline.com/.

You can connect to your organization’s PCO account two different ways. The first way to do this
is to simply choose New PCO Playlist in the Playlist manager and log-in through the interface
shown below. The second is through ProPresenter’s Network Preferences menu. This will be
covered later as there are other settings available from there.

| I . . ——
800 Authenticate

= planning
ﬁ,pcenter

Must Be Logged In To Access This Page.

forgot password?

E-mail Address: T
password: [

V] me Go

Anyone who can log into your organization’s PCO account can use this feature with their own
credentials, or you can select remember me and allow everyone to use the same login.

After you login, you will see a second window asking you to authorize ProPresenter to connect
to your account.
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Once you have connected to PCO and authorized your account to be used by ProPresenter, you
will see a list of all the available services in PCO. This is also the window you will be taken
directly to when you add future PCO Playlists in ProPresenter since you will already be
connected to your account.

- =
First Church Of La Quinta

Children's Ministry

Other Productions
Student Ministries
Weekend Worship Services !
Airturn ‘
East Valley Campus
La Quinta/Main Campus
Southwest Campus
Weekend Experience (North Campus) !
[Testing] &/
[TestFolder] ) 4

Once you have found the service that you would like to add to ProPresenter, click on the plus (+)
button in the lower-right corner.

During the import process, ProPresenter will attempt to find songs in your Library that match
songs in the PCO playlist. If it finds files, it will automatically link them for you. If no matches are
found, you will need to add the songs to ProPresenter and then link them to the PCO playlist.

After you have added a PCO playlist, you’ll notice there are several icons shown in the Playlist
that aren’t available in a regular ProPresenter playlist. ProPresenter 5 can recognize the extra
playlist elements that are available in Planning Center, making these playlists even more useful
to you and your volunteers because you can add notes directly in the playlist.

One of the key parts of this new feature is that your ProPresenter song files can be uploaded
and stored in Planning Center for future use. Once ProPresenter has scanned your PCO playlist
for changes, you will see an alert about attachments at the top of the playlist.

| Contiguous |

L Sunday ! Attachments
L] Youth service [

il Old services
[E] November 1, 2011

*

™ Amazing God

~) Prayer by Pastor Mike
Cannons

[7] The Wonderful Cross

™ 'Til I See You

Clicking on Attachments will allow you to upload or change files as needed in the playlist to
reconcile ProPresenter and Planning Center.

You can also right-click on the playlist name and choose Refresh if you need to update any files.
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As you can see in the image below, there are some local files that need to be uploaded, and one
that already exists in Planning Center that needs to be updated.

- |
(S XeNG) Plan Issues

' Problems were detected in the Planning Center Online plan.
L

Plan Item Issue Resolution
Amazing God Local file (Amazing God.pro5) needs
upload

Ignore

PCO file needs to be downloaded, bu
"TEST 1.pro5" already exists in the

The Wonderful Cross Local file (The Wonderful Cross.proS)
needs upload

'Til | See You Local file ('Til | See You.pro5) needs
upload

All Hail The Power Of Jesus Name Local file (All Hail The Power Of Jesus

v Ignore
Download (Overwrite)
Download (Copy)

Ignore

lanore

For the song “Amazing Grace”, which is a local file, there is an option to Ignore (shown) or to
Upload (not shown). Choosing Ignore will not upload the file to Planning Center. If you choose
to Upload, the .pro5 file will be linked to the song in Planning Center.

The second song, “Cannons”, exists in the Library and in Planning Center. You can choose to
continue using your Library file, overwrite the file in your Library with the one from Planning
Center, or create a new copy in your Library. Click Apply to make the necessary changes to the
Library and the playlist.

Once a ProPresenter presentation has been included in a PCO playlist, it’s considered Linked. If
you realize that the song version of a song was linked to the PCO playlist, you can unlink it by
clicking on the Unlink button. If a file is missing from the PCO playlist, you can add it by dragging
the file from your Library into the area indicated.

The image below shows a PCO playlist in Contiguous view to make it easier to see these three
options.

() The Wonderful Cross Unlink A E’

! 'Til | See You
Message
i Announcements Link
Test Link
Intro Video Link
l Message by Pastor Carl Link
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Slide and Table View

ProPresenter 5 offers two ways of viewing presentations. The default view is the Grid View,
which shows larger thumbnails of each slide.

Grid View is designed to show you a large thumbnail of your slide so that you can easily see the
design of the slide. This is referred to as a “what you see is what you get”, or WYSIWYG, type of
layout.

Table View shows you a smaller thumbnail, but shows makes it easier to read the slide content.
Slide notes are also visible in this view.

You can toggle the slide view and the thumbnail size using the buttons and the slider in the
lower-right corner of the slide viewer.
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Working with Slides

It's important to note that ProPresenter is always “live”. When you click on a slide, it will
immediately be sent to your output screen. Any media will also be shown if included with the
slide. When a slide is live, it has an orange outline around it so that you can quickly see which
slide is being shown. In Table View, the entire row will be orange, as shown in the previous
image.

.

¢ here is love

vast __as&he ocean

00:00:30.03

When a background video or image is added to a slide, it is indicated with the icon in the upper-
left corner. This icon will match the Backgrounds and Foregrounds icons from the Video/Image
Bin. If you have added a video to a slide, a box in the lower-left corner will show you how long
the video is. Other icons will appear in the upper-right corner; those will be covered in other
sections throughout this user guide.

If you need to re-arrange slides, you can simply click and drag the slide to the new position. In
previous versions of ProPresenter, you needed to also hold the Command key while clicking, but
in ProPresenter 5, simply holding down the mouse button while dragging a slide is all that’s
necessary.

Another new way of re-arranging slides is through Slide Grouping and Arrangement. This is a
new feature in ProPresenter 5. This feature will be covered in more detail later in this user
guide.

Slides can be duplicated within a presentation, making it easy for you to create slides for
repeated sections of a presentations. Duplicating is similar to copying and then pasting a slide.
To duplicate a slide, select the slide while pressing the Command key and then press Shift-D. You
can also right-click on a slide and choose Duplicate.

ProPresenter also allows you to disable specific slides. To disable a slide, right-click on it and
choose Disable Slide from the menu. To re-enable the slide, right-click on the slide and choose
Enable Slide. A disabled slide will be skipped when advancing through a presentation using the
space bar or arrow keys, and will also be grayed out to indicate it is disabled. Disabled slides can
still be used if you click on the slide or use a hot key to select it.

As you can see in the image above, this slide is marked with “Verse 1” and is blue. Slides can be

labeled and grouped together in ProPresenter. Due to the new use of these labels, these will be
covered in the section on “Slide Grouping and Arrangements” later in this user guide.
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Slide Grouping and Arrangements

One of the questions that we get a lot from customers is: “Can | have a different version of a
song without having to make a copy of it?”. In ProPresenter 5 we’re excited to say that the
answer to that question is: “Yes, you can!”

Slide Grouping and Arrangements utilizes slide labels to create “groups” within the presentation
that can then be used to create an endless variety of arrangements for that presentation.

To access the Groups and Arrangements manager, click on the Grouping and Arrangements icon
in the upper right corner of the presentation. When in Contiguous mode, this icon will be
available in the title bar of each presentation.

Great is Your love and justice God of Jacob
You use the weak to lead the strong
You lead us in the song of Your salvation
And all Your people sing along

4. Verse 2

After you click this button, a new menu will be revealed at the top of the presentation. From
here you will be able to create new arrangements or choose existing arrangements. In order to
use this function, every slide in a presentation must be part of a group.

Here Is Love E3 3

To get started you will need to add a new arrangement. Click on the options menu (gear icon)
and choose Add New Arrangement.

Here Is Love
D versei ¥ Chorus Y Verse
L Versel | chorus ) verse
Master

Add New Arrangement
Arrangement Manager

—
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After you choose Add New Arrangement you will be prompted to give the arrangement a name.
When you create the new arrangement, the slide view will be blank because the program is
waiting on you to create a new arrangement for the presentation.

Creating arrangements is as easy as dragging the group name tokens from the top row into the
lower row. The top row is considered the Master arrangement. This is the default layout of the
presentation. Dragging tokens from the Master arrangement to the new arrangement will add
the slide groups in the order you arrange them.

Here Is Love - [ Arrangement: Standard ]

2 C Verse 1 )C Chorus )C Verse 2 )( (BRIDGE) )( (ENDING) )

(" verse 1 )(" chorus )( verse2 )( (BRIDGE) ) (S

By introducing Arrangements in ProPresenter 5 we are also able to address another common
request that we get. When you make a change to a slide in a Group, every other instance of that
slide in the Arrangement is also updated. That means if you're arranging a song and you find a
misspelled word in the Chorus, you no longer have to change multiple slides every time you
repeat chorus in the arrangement. Simply select one of the slides to edit and all of the others
will be updated simultaneously.

If you need to delete arrangements, click on the Option menu again and choose Arrangement
Manager. This will show you a list of all the arrangements that you have saved. Select the
Arrangement that you want to remove and press the Delete key on your keyboard to remove it.

Arrangements can be used with presentations in the Library or in a Playlist. If you select a
presentation from the Library and then select an arrangement, the arrangement will only be
active as long as you viewing that presentation. When you select a different presentation the
arrangement will revert to the Master arrangement. However, when you change the
arrangement of a presentation in a Playlist, it is stored as the active arrangement. You can have
multiple copies of the same presentation in a playlist and each instance can have a different
arrangement selected.

If you are using anything other than the Master arrangement, you will see that indicated in the
title bar of the presentation, as shown in the image above.

Arrangements are included with the presentation data, so when you export files to use on
different computers, the arrangements go with the files.
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Document Properties

Every presentation in your Library has the ability to support additional data about the file. This
will typically only be used for songs since the primary data is copyright information.

To access this information, click on the blue info button to the left of the presentation name in
the slide viewer. When you click this button, it will open the panel shown in the image below.

Here Is Love

= EX

Title: Here Is Love Chord Chart Last Used: 11/5/11

Display Copyright _ _ Background: =m

Song #: 3287884 Size: | 19

©Year 2004 v Category: |

This information is automatically included on any song imported from SongSelect, or that has
the copyright information properly formatted in a text file. The copyright information is used
when displaying the copyright information, which is covered later in this user guide.

The only new feature available in this section is the addition of the Chord Chart option.
ProPresenter 5 now supports the ability to display a PDF file on the Stage Display. If you have a
single PDF for the entire song, you can choose to add that here and it will show on the Stage
Display the entire time you are using this song. Using PDFs to display chord charts will be
covered in more detail in the Stage Display section later in this user guide.

Notes that are added here are shown at the top of the presentation in a dark gray bar above the
title. Notes are useful if you need to include a general reminder about something related to the
presentation for the person running ProPresenter.

In addition to the copyright information and the chord chart, you can also change the default
slide color, size and category of the current presentation if you need to. Clicking the blue info
button a second time will close this panel. You can also access this same information in the
Editor, which is covered later in this user guide.
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Transitions

Another new feature in ProPresenter is the addition of transitions for slides. In previous versions
transitions were limited to either a cut or dissolve transition. In ProPresenter 5 there are several
more options now available. Transitions can also now be applied globally, per presentation, and
even per slide.

The image below shows the document transition settings. Instead of a slider at the bottom of
the slide viewer like in ProPresenter 4, there is now a new menu in the upper-right corner of the
slide viewer for transitions. The icon will show what the currently selected transition is.

Flip Cube Door

- ﬂl- |« - = - IIIHM'

Top Left Top Right Right Bottom nghl _ Bottom Left Center

Ajvjefrjefl «falrfn

Top Left Top Right Center Right Bottom Left Bottom Bottom nght‘

¢ Duration: m Motion Extended  Speed: Duration: Done

The first row of transitions are fairly standard slide animations that you can set the duration for.
The next two rows are text motion paths. These transitions have the standard duration option,
but also have an extra option called Motion Extended. When you enable this option, the text
will transition like normal to it’s slide position, but then it will continue moving at a slower rate
in the same direction.

If you want to set a global transition that is used by every presentation (unless a document or
slide transition is enabled), click on the transition menu in the lower-left corner of the slide
viewer. To apply a transition to a slide, right-click on the slide and select the Transitions menu
item.

Quick Edit
Edit Slide

Disable Slide
Transitions.

Template >
Hot Key

Clear Cues
Go to Next Timer,
Loop to First Slide
Add Live Video Cue
Add Media Cue.

Video/Image Bin Sort By Nar

Group Label » S
Group Color >

i Backgrounds = p— Copy

Cut
Paste
Delete
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Resizing Presentations

There may be times when you are given a presentation to use in ProPresenter that was created
on a different computer that had a different output resolution set. When this happens, you will
see a yellow triangle in the upper-right corner of the slide viewer. When you click on this alert,
you’ll be shown a message like the one below telling you what size the document will be resized
to. All slide elements will be scaled correctly to maintain the same look on your slides.

[ [w]

1

7 I N LA R

Editor Video/Image Audio M ges Store SongSelect Bibles DVD Tw

‘r* — The resolution of this document does not L

PI’Q match your output resolution. Would you
like ProPresenter to correct this issue?

This will resize all the slides in the document to fit
the current output resolution (1920x1080).

Cancel ) ( Resize )

If you need to resize a lot of presentations at the same time, you can select multiple files in the
Library, then right-click and choose the correct size from the Resize menu. If one of the four
standard options doesn’t work for you, click on Custom Size and enter the correct dimensions.

Have Thine own way, Lord Hymn 12/27/01

Help Me to Find You Contemporary 12/27/01

Here Is L¢ Reveal in Finder n 11/5/11

Hope of ( rary 12/27/01

How Can Rename 12/27/01

| Believe Category p rary 12/27/01

nave 2 TSN 800 x 600
Reflow 1024 x 768
Duplicate 1280 x 720
Delete 1920 x 1080

| Youths 3 y

] Old ser Print Custom Size...

[ Nothing But the Blood
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Editing Slides

ProPresenter offers a few ways to edit presentations. Individual slides can be changed using
Quick Edit, the overall look of a presentation can be changed using the Format menu, or you can
make extensive edits using the Editor. Templates can also be used to change the look of a
presentation, but that will be covered later in this user guide.

The quickest way to edit a slide is with Quick Edit.

The Quick Edit function allows you to make simple changes to individual slides. This is useful if
you find small grammar or spelling mistakes or realize you need to change a line break or other
simple change. The Quick Edit window is a small, floating edit window that opens when you
right-click on a slide and select Quick Edit. You can continue selecting on other slides while this
is open.

In the image below you will notice that “remember” is misspelled. By opening Quick Edit, it only
takes a few seconds to correct the spelling. Clicking the ‘X’ in the top-left corner of the Quick
Edit window applies the change to that slide immediately. As mentioned earlier in this user
guide, if you have your slides grouped together, every repeated instance of that slide will also be
updated. In the image below, the slide being changed is the first slide of the Chorus. Since the
chorus of a song tends to be repeated several times in a song, being able to change this once
saves even more time.

loving-kindness when the Prince
as the flood of Life our Ransom

who His love

will not remmber
His love
t remmber
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The second way to edit a presentation is with the Format toolbar. The location of the Format
button is a minor user interface tweak from ProPresenter 4. Instead of being located in the title

bar of a presentation, this is now a button in the toolbar. Clicking the Format button will reveal
the toolbar shown below.

7| §: @, [ n

N B Gl : l ]
Editor Video/Image Audio

Messages Store SongSelect Bibles DVD Twitter

| 3N AR 6T

Format Timeline

| xingthings Tr | 72 % B

Here Is Love

« here is love
vast ‘_as.he ocean

-

loving-kindness

as the flood

00:00:30.03
1. Verse 1

As you change the different formatting options, the presentation you’re working with will be
updated immediately so you can see the changes. If you need to make changes to multiple

presentations, just click the Apply All button as you select the rest of the presentations to apply
the same settings again.
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The Editor is the most robust way to edit a presentation. Here you have full access to the slides
and can modify the contents of the slides and edit all of the various properties of the
presentation. Since the Editor is a WYSIWYG (what you see is what you get) editor, what you are
seeing in the editor is exactly what will be shown on your output screen.

To open the Editor, click on the Editor button in the toolbar, or right-click on a slide and select
Edit Slide.

To begin editing a slide, select the slide you want to work with from the thumbnails on the left
side of the Editor. This will change the slide that is open in the Editor. If you are done editing a
presentation and need to edit another one, you can select the other presentation without
having to close the Editor. You can also edit presentations even if you have another one running
as a slideshow loop or have any slide or video showing.

BOEEEE

.
. .
¢ here is love
vast as‘t’he ocean

Use the buttons in the lower-left corner to add new slides as needed. These two buttons are the
same ones from the Slide Viewer.

The first five buttons across the top of the Editor are used to add slide objects. These objects
are: Text Box, Shape, Image, Video, and Live Video. Slides in ProPresenter can support any
combination of these objects on an individual slide. Click on the object that you want to add to
the slide, then resize and position it where you would like it to be on the slide.

The next button opens rulers on the left side and top of the Editor to make it easier for you to

size and position objects on the slide. The last two buttons are used to change the arrangement
of layers on the slide. The first is Bring Forward and the second is Send Backward.
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If you are trying to center an object on the slide, yellow crosshairs will show up when you have
reached the vertical and horizontal center points.

here«is love*:

- - - -~
vast ass the roceans

+

If you want to change the zoom level of the slide, click on the zoom menu in the lower-right
corner and select a new zoom level. By default this is set to Scale to Fit so that you can see the
entire slide regardless of your screen size or layout.

The column on the right side of the Editor is where most of the functionality exists. There are
five different sets of properties that you can change.

The first set of properties are the Document Properties. This is the same information that can be
edited in the slide viewer and was discussed earlier in this user manual.

ESNCHENEEE:

(") Background |

Size:

1920 x 1080 3

Category:

Presentation 3

-

Title:
Here Is Love
Artist:

Author:

Matt Redman, William Re
Publisher:

Thankyou Music (Admin
Song #: 3287884 @M

® Year: 2004
Notes:

Chord Chart:

© 2005-2012 Renewed Vision, Inc.

On this panel you can override the default background color set in
Preferences for this one presentation. You can also change the size of the
document and the category of the presentation.

If you set a transition it will apply for the entire presentation and override
the global transition.

The bottom section allows you to edit the copyright information, add
notes for the person running ProPresenter, and add a PDF chord chart to
be shown on the Stage Display.

If you add a chord chart on the Document Properties tab, that PDF will be
shown the entire time you’re on this presentation unless you have a PDF
linked to an individual slide. If your PDF for the song is only one page, this
would be the ideal place to add it. More detail on adding chord charts will
be covered in the Stage Display section later in this user guide.
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O # The second set of properties are Slide Properties.These settings apply to

@ Enabled the current slide only.

[7) Background P

If you need to disable a slide, uncheck the Enabled box. If you need to

change the background color of an individual slide, you can do that by

m- enabling the Background option and selecting a color. Hot keys are used
to trigger slides using your keyboard; these can be any letter from Ato Z.

Hot Key: a

[T] Layer 1

5 If you set a transition here it will apply to just this slide.
T| Layer 2

4|

If you have multiple objects on a slide, it can become difficult to keep
Licl I— track of the order of the object. Clicking on the layer will select the object
verse 1 ’ that it goes with on the slide so you can identify which object is where.

Notes:

Mark sings lead on
this song. The slide label shows up as the name of the slide. These are used to

identify slide groups and to create groups and arrangements.

Chord Chart:

=y If you need to use multiple chord charts throughout the presentation, add
them to the appropriate slide that they need to be shown with.

0 **  The third tab is the Object Properties tab. This is where you adjust the

X: 43142 W: 1057.. general properties of slide objects.
Y: 247.61 H: 584.78

/"7\‘\ . H . ’
angie: [0 | (%) The top section of allows you to change the coordinates of an object’s

position, as well as its size and rotation.

“r

Name: Default
The Name label doesn’t apply to regular slides, but is used with the
Twitter module and Bible templates, so it will be covered in those
sections.

(] Fill Color |
[ Line Color  #»~

Line Width: 0

Corner Radius: 0

The Fill Color is used to change the color of a shape or the color of a text

@ shadow | mm box. Fill Color also supports opacity. The Line Color changes the outline of
Angle: [o° |1 (%) the object or text box and Line Width is the thickness of the line. Corner
Length: | 0.0 | Radius controls the roundness of the corners of an object or text box. If
Radius: 8.0 you need to make a circle, enter 360 in this box.

The Shadow settings can be used on slide objects or on text. The Angle of
the shadow is similar to what direction you want the shadow to come off the object or text. The
dial next to Angle allows you to quickly adjust the position of the shadow. Length controls how
far away from the object or text the shadow is and Radius controls the blurriness of the shadow.

Tip: If you have very intricate fonts, a high radius value may cause some performance issues.
If you have a shadow applied to text, and then add a fill color to the box, the shadow will move

from the letters to the text box automatically. So if you need to have the shadow on the text and
a colored box behind it, you will need to add a shape object behind the text box.
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O % The fourth set of properties are the Text Properties.

Edit Text Style: i
The top section allows you to choose your font, font color, font styles, and

\ ) . .
w color. You can also add an outline to text and select an outline color.
\&&lar :
(=) () ()
e Tracking and Leading may be two terms you aren’t familiar with. Tracking
Size: (52 s refers to the amount of space between the letters in a single line
Outline: 1 /[ . . . .
= (horizontal spacing). Leading refers to the amount of space between lines
TL'“:{"Q' % o = of text (vertical spacing). Leading is not supported by the Windows
ing: v . . . ’
cacing © 1A version of ProPresenter, so this setting won’t transfer between platforms.
\

() Adjusts to Fit

The next area controls the alignment of the text. The first row is the

. = horizontal alignment of the text and the second row is the vertical
(_ApplyAll_| alignments. Checking Adjust to Fit will dynamically resize the text box as
Text Reveal needed'

| None

If you click Apply All, all of the settings on this panel will be applied to the
other text boxes in your presentation.

Text Reveal is a new feature in ProPresenter 5. One of the primary reasons many of our users
still use PowerPoint for their Pastor’s sermon notes is the need for bullet lists and fill-in-the-

blank slides.
m—— To use the new Text Reveal function, select either Bullet List or Fill in
the Blank from the drop-down menu. This will change the
BiilleC st functionality of the selected text box. It is not possible to combine
v Fillin the Blank [ the two functions in a single text box.

ChuakFive
Regular

e
r W i

Creating a Bullet List is as easy as pressing the Return key and creating a new line of text in the
text box. If you want to add bullet characters, click the Ruler at the top of the editor. When you
have a text box selected, you’ll see options to add bullet symbols.
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When you have a slide that has a bullet list or fill in the blank, you will see dot indicating the
number of builds on the slide. Each time you click on the slide, or use the keyboard to advance,
one new level will be revealed. If you need to go backwards on a slide, use the left arrow key on
your keyboard.

Below you can see an example of a bullet list and a fill in the blank slide along with the output
view.

Slide Reveals

»First point. -First point.
« Second point. +Second point.

»Third point.

Slide Reveals

The first keyword. The first keyword.
The keyword. The second keyword.

__ third keyword. The third keyword.

If you happen to create a slide with more reveals than your slide can display, it will change from
the dots to a numerical indicator of where you are in the list. This can be seen in the image
below.

D NI O L

S o

N
L
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& 2+ The fifth properties tab is the Image/Video Properties tab. This tab
can only be accessed if you have an image or video, or live video,

h : .
Changs Source. NS object on a slide.

| Scale to Fit o)

If you have added an image or live video to the slide, only the top

Voli e | 1% section will be shown.
Rate! e s 1%
start: | 0.0% %) You can change the source of the file while maintaining any other

end: [ Tox 1A value you've set for the object. If you need to find out where an
" —— image or video is located, click on the magnifying glass to open it in

Behavior: | Stop B the Finder

The drop-down menu allows you to select different scaling options for
the image or video. These options change the way the image or video
is displayed within the boundary of the object’s box.

If you have added a video file or live video object to the slide, you will have the second set of
options available. Since you don’t have full playback control of a video on a slide like you do with

a video played as part of a presentation or from the Video/Image Bin, you have to adjust some
of the settings here.

The Volume slider will change the volume of the video if there is an audio track. The Rate slider
will change how slow or fast the video plays.

If you need to adjust the Start and End points of the video, you can enter the values here. These
values are calculated as percentages, so you may need to test these settings to get them right.

If you need to change the way the video plays, click on the Behavior menu and select Stop,
Loop, or Palindrome.
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Go to Next Timer

A common need in ProPresenter is the ability to create an announcement loop from a series of
slides, graphics, or short videos. There are two easy ways to do this. The first is to use a Go to
Next Timer, the second is to use the Timeline. The timeline method will be covered later in this
user guide.

A Go to Next Timer can be applied to slides, images or videos in a presentation. A timer can’t be
applied to media in the Video/Image Bin.

While using a Go to Next Time is simple, it does take a little bit of prep work to make sure it
works the way you want it to and the way you expect it to work.

Before creating your timer it’s important to know the difference in how a Go to Next Timer
works with Foreground video versus Background videos. There is no difference with slides or
graphics.

| start of the video. This means that if your video is 30 seconds long, but your timer is set
to 10 seconds, then the video will only play for 10 seconds before advancing. If your
video is 30 seconds long and your time is 45 seconds, then the video will play one complete time
and then advance halfway through the second time.

E—E Backgrounds: If your video is a Background, a Go to Next Timer begins counting from the
-

.«»+ Foregrounds: If your video is a Foreground, a Go to Next Timer begins counting at the
end of the video. This means that when your video ends, then the timer is triggered. If
you have a 30 second video and a 10 second timer, your video will play completely one

time, then wait 10 seconds before advancing to the next item. If you want the videos to play one
right after the next, set the timer to 0 seconds.

You can set a timer from two different locations. The easiest option is from the toolbar. Click on
Format then on the clock icon. There are only a few standard options available here. Selecting
one of these will apply the time to all the slides in a presentation. The last slide in the
presentation will also automatically have a loop to first slide cue added.

Remove All
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The second, and more flexible, option is to select all the slides that you want to add a timer to,
then right-click on any one slide, and choose Go to Next Timer from the menu. You can enter
any value, in seconds, that you want to use for the transition time. Remember that if you are
using Foreground videos and want them to advanced automatically, use zero seconds.

cTe"e Timer Settings

Set the amount of time, in seconds, that this slide will
be displayed on screen. Press clear to remove.

In the case of foreground videos, this is the amount of time the
last frame of the video will be displayed

Seconds: [E] @ [ Loop to first slide
( Clear ) ( Ok )

If you need to enter different values for individual slides, you can edit the timer settings for each
slide. If you want your presentation to loop continuously, check the box next to Loop to first
slide on the last slide in your presentation. You can also assign a loop cue by right-clicking on the
slide and selecting Loop to first slide without entering the Timer Settings.

If you have added a timer or loop cue to a slide, it will be shown in the upper right corner of the
slide so that you can quickly see what the settings are for that slide.

When you are showing slides with a slide timer, you will see a stop sign icon with a clock on it

under the playback controls. Clicking this button will stop the timer from running until you click
on a slide again.

00:00:05

«“« <« ] » »
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Hot Keys

Hot Keys allow you to assign specific letters (A through Z) to slides. Some users prefer to assign
letters to certain parts of songs to make it easier to quickly jump between sections. To add
alphabetical hot keys to slides, right-click on a slide and choose Hot Key from the menu. This will
open a window that allows you to assign any lowercase letter to that slide. You can also edit the
hot key assigned to a slide in the Editor from the Slide Properties tab.

0|8 & A %=

2’ Enabled

) Background P

Clear ) ( oKk ) S
Hot Key: A

Enter Hot Key to trigger slide:

¢ | (Valid characters: a-2)

(cancel ) (

You can also select slides using a numeric keypad or the number row on your keyboard. To jump
to any slide, type the number and press Enter on your keyboard. The slide will be selected
immediately. The slide number is found in the lower left corner of the slide thumbnail.

montal ilis prevailing

The splendor of the King
Clothed in majesty

Did we T Our Strengtihi contide, our
striving would be losing;

You have two seconds between key strokes to enter another value. After two seconds, if the
enter/return key has not been pressed, the hot key trigger window will automatically close.
Pressing the escape key will also close this slide selection overlay.
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Saving Files

Since ProPresenter does not have an auto-save feature, it’s important to remember to save your
changes regularly. The fastest way to do this is by using the standard Command-S shortcut. You
can also choose from the Save options under the Flle menu.

BN Edit Actions View Format W

New 3#EN
Import B
Select Library >
Save All 38S
Save As... {+8S
Save Selected

Revert to Saved

Save All will save all the changes you’ve made throughout your Library.

Save As... will allow you make a new file from the one you’re working on.

Save Selected will only save the selected Library files.

Revert to Saved will undo all changes you’ve made since the last time you saved.
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Slide Reflow

Slide Reflow is a new feature in ProPresenter 5. In previous versions of ProPresenter the only
way to edit the content of a presentation was directly in the Editor. This can be a tedious
process if you need to merge slides together or make a lot of adjustments to the text and don’t
want to have to scroll through a lot of slides.

SNOo Import
| save As... || save |
Title: Amazing God size: | :
Artist: Display Copyright Category: [ Presentation +
Author: Brenton Brown Song #:
Copyright:  Thankyou Music (Admin. by EMI Christian Music Publishing) ©Year: 2008 Template: | ) ~ |

From the north and soutn
We are crying out B
There is hope in Jesus' name

2. Chorus v
‘Cause You're amazing God

You're amazing God

You can bear the weight

of evry heavy heart

Il

Youve amazing Ged

2. Chorus 3. Chorus

Sants in evry generation
Singing for Your glory
Teiting what You've dene

3. Chorus

You can heal the pain

You can clean the stain
You can turn our tears into songs of praise - 5. Verse 1
You're amazing God

<
Il

4. Verse 1 v
We can hear it growing louder ou s 50095 of pravee surreund us
Songs from ev'ry nation
Rising to Your throne

5. Verse 1 v=
Saints in evry generation

Singing for Your glory

Telling what Youve done

6. Verse 2 v=

Insert Slide Break [ —0O— 4

There are three ways to access the Reflow feature. The first is when importing a new
presentation. Click on the button with the double arrows then click on the Edit button. If you are
importing multiple files, select the one you need to edit.

- Yale) Import
Parsing
All Because of Jesus.txt Slides delimited by Paragraph Break z]
delimiter(s) per slide
Document
Size: | 1280 x 800 -
Category: [ Presentation =
Template: -
v
Destination
Library =

Cancel ] [ Import All
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The other two ways to use the Reflow tool is with existing files. You can open this from the File

menu (File>Reflow Presentation) or by right-clicking on a file name in the Library and selecting
Reflow.

While simple to use, the Reflow editor is easier to understand if you can see it in action. Take a
look at this tutorial video for more information about this feature.
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Importing and Exporting Files

This section will cover the various import and export options available from the File menu in
ProPresenter 5.

To access the Import options, click on File>Import and choose the option you want to use. You
can also drag files from the Finder directly to the Library or Video/Image Bin to start the import
process.

The different Export options are at the bottom of the File menu. You can also export files by
right-clicking on the name and choose Export or dragging the presentation or playlist to a folder
on your computer.

il Edit  Actions View Format Window Help

New ®BN ProPresentet
~ Import > Import Fi
Select Library > Import Video/Image...
5 \ag
Save All #S Import Copied Text...

Save As... 0 8S
Save Selected
Revert to Saved

Import PowerPoint...

Import ProPresenter3...
Import ProPresenter4...
Save Selected Slides As Template... ' - I

Export Templates...

Reflow Presentation...
Export as Plain Text...
Export as Pro5 Bundle...

Export Playlist...
Export as Pro4

mmmm Seabar

Print... 8P
Import File
8006 LBk This option is used to import text files (.txt or .rtf) or
o Word files (.doc or .docx).

Slides delimited by Paragraph Break 3

delimiter(s) per slide

Document

Size: | 1600 x 1000 -

Category: [ Presentation

Template: -

Destination

“r

v

“ar

Library

[ Cancel ] [Import All ]

After you select the file that you want to import,
you'll see the menu to the left. There are two
options for how you want the text in your file broken
Paragraph Break, each paragraph in the file will be
created as a new slide. The second option is Line
Break (not shown). We've improved the Line Break
option so that you can now set how many lines you
want per slide. If you want 1, 2, 3, 4, or more, lines
on each slide, just enter that number.

The middle section allows you to update the size,
category and template that will be used for the file
you’'re importing.

You can also decide if you want the file to go to the
Library, to just the selected Playlist, or to a new

Playlist. If you choose New Playlist you’ll be prompted to enter a name.
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The button in the lower-left corner opens the new Slide Reflow feature. Using Slide Reflow will
be covered later in this user guide.

Import Video/Image
This option opens a new Finder window. Navigate to the video or image that you want to import
and select it. The file will automatically be added to whichever bin or playlist is currently

selected in the Video/Image Bin.

Import Copied Text

This option uses the same import options as Import File, but allows you to copy text from a
website or a file such as a PDF or other file type not supported by ProPresenter and import it

into the Library.

Import PowerPoint

If you have PowerPoint installed on your computer, you can convert PowerPoint files into files
ProPresenter can use.

Note: PowerPoint 2008 or 2011 will work if you are running Snow Leopard. If you are
running Lion, you will need to have PowerPoint 2011.

N.O)LO Import PowerPoint Presentation

Select one or more PowerPoint presentations to import.

(<« » | [23.=i m) [ (] PowerPoint files ?] Q
- Name A | Date Modified
PLACES ' Doxology (extended version).ppt 4/25/08
£ chris < Habakkuk2.pptx 9/28/10
[ Desktop o == lookattheworld-textonly.pptx 11/9/10
/A Applicati... " service.ppt 9/16/10

] Documents
() Downloads
F Music X

@ Import All Slides as JPEG Images
() Import Text Objects as ProPresenter Slide Elements
() Import Text and Graphic Objects as ProPresenter Slide Elements

| ———
[ Cancel ) Open
Se———

Once you have located the PowerPoint file that you want to convert, choose the option that you
want to use before clicking Open. Native PowerPoints with full animations and layers can not be
imported this way. Keynote files can not be converted at all. If you need to use a PowerPoint file
or Keynote presentation with full animation, drag the file from the Finder directly into a Playlist.
This will create a trigger that opens the correct program to run the program.
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Importing data from ProPresenter 3

The following steps require ProPresenter 3 to be installed on the same computer as
ProPresenter 5.

When the ProPresenter 3 Data Import menu opens, you can select from either a Basic or
Advanced set of options.

Basic is the easiest method. Select any, or all, of the three options, then click Import to copy the
data into ProPresenter 5.

Advanced allows you to select more options for importing such as specific files or playlists if you
only want parts of your ProPresenter 3 content. Select the options you want to use, then click
Import.

Title
) A Mighty Fortress is Our God
) All Because of Jesus
) All for You
) Amazing Grace
) Angels from the realm of glory
() Angels we have heard on high
) Apart from You
) Away in a manger
) Battle Hymn of the Republic
) Be Thou my Vision
() Blessed assurance
) Burn for You
() Can 1Sit: Here i am for you
) Captivate

For more information about importing your data from ProPresenter 3 that is installed on a
different computer, refer to Knowledge Base Article #80.
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Importing data from ProPresenter 4

ProPresenter 4 is required to be installed in order to import your files using this method.

Convert Pro4 to Pro5

Select ProPresenter 4 Libraries you wish to import into the ProPresenter 5 file format. You
can edit the "New Location” of the ProPresenter 5 library in the table below.

|

| Library New Location 1‘
U Default ~/Documents/ProPresenter5

H?] Pro4 Library ~/Documents/Pro4 LibraryPro5 ‘

HZ] ProPresenter4 ~/Public/ProPresenter4Pro5 ‘
# Include Playlists, Media Bins and User data ( Ccancel ) ( Import )

From this window, select the library, or libraries, that you want to convert to ProPresenter 5
files. If you check the “Include Playlists, Media Bins and User data”, this data will also be
imported and converted to the correct format for ProPresenter 5.

If you want to change New Location option beside a library, double-click the file path and type
the new path. Remember that ~ indicates your current user folder on the Mac.

If files are detected in ProPresenter 5 that already exist you will be asked to either Skip, Add
New Version, or Write Over the existing file.

"Apart from You.pro5" already exists in the Library. Do you
IP' rl@‘ want to replace it with the one you're moving?

[ Applyto All [ Skip Y ( Add New Version ) ( Write Over )

© 2005-2012 Renewed Vision, Inc. Page 77 of 131



ProPresenter 5 for Mac User Manual

Export Template

Export Template

Select Templates to Export

™  Bible Lower Third.pro5Template
@ song - left-middle aligned.proSTemplate
™ song - right-bottom aligned.pro5Template
8  ccli.proSTemplate

twitter.proSTemplate

~ Cancel ) [ Export 3

In ProPresenter 5 we have added the ability to easily export templates to be used on another
computer. Instead of having to search through the FInder to find these files and manually add
them on another computer, you can now export specific templates to a single bundle file. When
you double-click this file on another computer, the templates will be imported and be available
for immediate use.

Export as Plain Text

This option will export the select presentation(s) as a plain text file with a .txt extension. This
export method strips all formatting except line and paragraph breaks.

Export as Pro5 Bundle
Bundles are used to gather Library files and media files together into a single package that can
be opened in ProPresenter on another computer running ProPresenter 5. If you select multiple

songs in your Library, they will all be included in the same bundle along with the media.
Importing bundle file will add the files to your Library.
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Export Playlist

This option will export the selected playlist. When you export a playlist you can choose to
include the media with the playlist if you want. Importing a playlist on another computer will
rebuild the playlist exactly the way it is on the original computer. Playlists can also be exported
by right-clicking on the playlist name, or dragging the playlist name to a folder on your
computer.

Export as Pro4
This is a new option in ProPresenter 5. If you still have some computers that are using
ProPresenter 4, you can use this export option to create a file that will open in ProPresenter 4.

This removes all of the new ProPresenter 5 features like transitions, arrangements, and text
reveals.
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Printing

If you have used a previous version of ProPresenter you’re aware that the printing options were
limited. In ProPresenter 5 we’ve added a new Thumbnail View and updated the Outline View

options.
When you open the print dialog you'll need to expand the print options to see these features.

The two images below show the Thumbnail View and the options available as well as a section
of a sample print out.

® Thumbnail View
() Outline View
"I Document Information [ Media Thumbnails

"I Presentation Notes 1 T] & VT
|| Current Date

6\ ( PDFv ) [ Preview | “ Cancel ) ( Print )

Nov 10, 2011

Amazing God

Author: Brenton Brown
Publisher: Thankyou Music (Admin. by EMI Christian Music Publishing)
Copyright Year: 2008

'Cause You're amazing God
You're amazing God
You can bear the weight
of ev'ry heavy heart

e nerth and souly
We ere erying el

2. Chorus
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The two images below show the Outline View and the options available as well as a section of a
sample print out.

() Thumbnail View

® Outline View
"I Document Information ["1Slide Numbers
[ I Presentation Notes [1Slide Labels
"] Current Date [ 1Slide Notes
|| Disabled Slides
@ ( PDFv ) ( Preview ) (" Cancel ) ( Print )

Nov 10, 2011

Amazing God

Author: Brenton Brown

Publisher: Thankyou Music (Admin. by EMI Christian Music Publishing)
Copyright Year: 2008

Misc 1

1. From the north and south

We are crying out

There is hope in Jesus' name

Chorus

2. 'Cause You're amazing God
You're amazing God

You can bear the weight

of ev'ry heavy heart
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Song Select

SongSelect is owned by Christian Copyright Licensing International (CCLI). If you are an active
license holder of a CCLI license for your church or organization then you have the option of
purchasing a subscription to SongSelect.

For more information about CCLI and SongSelect, visit www.ccli.com.
If you have access to SongSelect, ProPresenter can store the registration information for you

and provide direct access to SongSelect through the program. This makes it easy to get songs
from SongSelect without having to leave ProPresenter.
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Accessing SongSelect

To access SongSelect, click on the SongSelect icon in the toolbar. This will open a window in
ProPresenter for you to enter your SongSelect registration information. After you enter your

registration info, ProPresenter can store it for you so that you don’t have to enter this
information every time.

EIEAEA G o " Store [ SongSelect

L |
- ™1 CcCLI

SongSelect / Copy Report Login

User ID

Password
Remember Me ¥
Login  Cancel

* Register (Create a new user account)
+ Forgot Your Password?
* Need Help Logging I

ing In?

After you have logged in, you can then browse the entire CCLI catalog in SongSelect and export
song files directly to your ProPresenter Library.
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Exporting from SongSelect

After you have searched for the song you want to add to your ProPresenter Library, you can
export it directly to your Library. To do this, click on the Lyrics tab and select Copy or Save

(as .txt file) or Export (as .usr file). Either option will open the Import panel in ProPresenter to
allow you to select your import settings. You can repeat this process for as many songs as you
need to in one session.

LYRICS | AUDIO | CHORD | LEAD | HYMN

B |« b | J] 4
=0
Chorus 1 % Left-Aligned Format
How greatis our God =
Sing with me —h
How greatis our God — Centered Format
And all will see how great e
How great is our God
=
5 Copy or Save
Verse 1 @"‘ﬂ (as .txt file)
The splendor of the King "
Clothed in majesty _—
Let all the earth rejoice = Export
All the earth rejoice = (as .usr file)

He wraps Himself in light
And darkness tries to hide

And tramhlac at Hic vunira
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PowerPoint and Keynote Triggering

Importing PowerPoint and converting it into JPEGs or ProPresenter slides has been covered
earlier in this manual. This section will cover importing PowerPoint and Keynote files as full-
feature presentations.

Due to limitations with PowerPoint and Keynote, ProPresenter is triggering the presentation and
relying on the appropriate program to play the presentation. This means that while a
PowerPoint or Keynote file is being shown, that program controls the output and any content
within ProPresenter (Mask, Props, Messages, etc) can’t be shown over the output content.

The process of adding a PowerPoint or Keynote presentation to ProPresenter for Mac is very
simple. Open a new Finder window and drag the file into a playlist. You will see the presentation
name listed the same way any item added to a playlist is shown. PowerPoint and Keynote files
are distinguished by using the application icon associated with the file.

Playlist Contiguous

After you select the presentation that you want to use, a slide for the presentation will appear in
the slide viewer. When you click on this slide, the appropriate presentation program will open
up over ProPresenter and switch the output to either PowerPoint or Keynote.

service

P

PowerPoint and Keynote files can only be added to a playlist and not into the Library or another
presentation file.
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Bibles

Downloading, Installing, Registering

One way to add Bibles to ProPresenter is to purchase and download directly from our website.
When you buy a Bible, you will be sent an unlock code that allows you to download your
purchased Bibles. Public Domain Bibles don’t require a code and can be downloaded at any time
from the website.

Once you have received your Bible unlock code, go to our website and enter the code. When
you click Enable, the purchased Bible will then be available for you to download.

When you purchase a license to a Bible from us, you will get an unlock code. Entering this code below will activate the
download button for the Bible you purchased.

Enter Bible unlock code: (_ Enable

LICENSED BIBLES:

( Add rew Bible )
(To add more than one bible to cart, select the check box in front of name and click on the "Add (_Add new Bible )

selected Bibles to cart” button at bottom of section)

Name Abbrev. Language Price Action
(0 21st Century King James Version K21 English 515
Deuel Enterprises

(O New International Reader's Version

ternational Reader's Version NIRV English s15
International Bible Society

(O New International Version -

o U NIV English 515

Zondervan 9 (O vac JO pc
(O New King James Version NKJV English $15
Thomas Nelson

When you buy a Bible, you will need to enter your ProPresenter registration information before
completing the purchase. Licensed Bibles are $15 and can only be installed on one computer.
There is no site license for a Bible.

After you have purchased and downloaded the Bible installation file, you will
v need to install it. Similar to how you installed ProPresenter, open the Bible disk
image from your downloads folder. When it opens, you will see the Bible
King James Version pkg installer package icon. Double-click this item to launch the Bible installer.

Follow the remaining on-screen prompts to install the Bible and enter your computer password
when prompted.

After the Bible has been installed you will need to enter the Bible unlock code a second time in
ProPresenter when prompted for it the first time you select the Bible translation. Public domain
Bibles do not require an unlock code to download or active.

The second way to add Bibles to ProPresenter is through the Bible module. To open the Bible
module, click on the Bibles icon in the toolbar. If you haven’t installed any Bibles, you will see
the image below in the Bible module. Click on the Get Bibles button to open the in-app store
page.

€©  Cesibles | (]
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If you have installed Bibles and need to purchase additional translations, the image below is how
the Bible module will look for you. Click on the Get Bibles button to open the in-app store page.

After you click on Get Bibles, you will see a window like the one shown in the image below.
Scroll down to the Bibles section and select the Bibles you want to install. Only licensed Bibles
can be added this way. If you are looking for a public domain Bible, click on the View Public
Domain Bibles to be taken to our website to download those translations. Bibles purchased this
way will automatically be downloaded and installed into ProPresenter.

& Renewegoyhision | 000

G R G
ENGLISH ENGLISH (CONTINUED)

21st Century King James Version (K/21) Revised Standard Version (RSV)
Publisher: Deuel Enterprises Publisher: Harper Collins Publishers
— Amplified Bible (AMP) The Message (MSG)
— Publisher: The Lockman Foundation Publisher: NavPress Publishing Group
— Contemporary English Version (CLV) — Today's New International Version (TN/V}
— Publisher: American Bible Society —  Publisher: Zondervan
— English Standard Version (£SV) PORTUGUESE
— Publisher: Crossway Bibles
— Nova Versao Internacional (PNVI)
— Holman Christian Standard Bible (+CS5) — Publisher: International Bible Society
- | seamnsn |
— NET Bible (NET)
— Publisher: Biblical Studies Press, L.L.C. — LaBiblia de las Americas (L8LA)
—  Publisher: The Lockman Foundation
— New American Standard Bible (NASB)
—  Publisher: The Lockman Foundation — Nueva Biblia de los Hispanos (NBLH) -
— Publisher: The Lockman Foundation A
New International Reader's Version (NIRV)
Duthlichar tntarnatinnal Bikla Carintu Nueva Versian Internacional /SNVI)

INFO Licenses may be purchased here within in the software provided the computer has an Internet connection.

Visit Renewed Vision to learn more about our products!
Cancel

“§2 RenewedVision w000
Be- B B

Iicensed Bible installed on that system. Licenses are not expensive, so please honor this arrangement by purchasing a

license for each environment you intend to use them from the publisher who has generously made their product available
for use in ProPresenter.

When you purchase a license to a Bible from us through the application, !he license will automatically be generated

downloaded, and installed on the making this upon a
PUBLIC DOMAIN BIBLES FREE

We have many Public Domain Bibles to choose from that are Free to the public. Please visit our
website by clicking the button below to browse our selection. If you find one you like, simply
download and install it so it will be available to you in ProPresenter (scroll to bottom of page).

View Public Domain Bibles

INFO Licenses may be purchased here within in the software provided the computer has an Internet connection.
Visit Renewed Vision to learn more about our products!

Cancel
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After you have purchased and installed a Bible, you need to complete the process by registering
the Bible in ProPresenter. To do this, select the Bible from the drop-down menu in the top-left
corner of the Bible module window. The window shown below will open for unregistered
licensed Bibles. Enter the unlock code for the Bible and click the Register button to complete the

process.
($) Bible
- Bible: | (NIV) New International Version
Publisher: | Zondervan
+ Language: @ English
Copyright: | Scripture taken from the HOLY BIBLE, NEW

INTERNATIONAL VERSION. Copyright 1973, 1978,
1984, 2011 International Bible Society. Used by
permission of Zondervan. All rights reserved.

License Name:

Unlock Code:  Register

@ (Get More Bibles) ( OK )

7

Public Domain Bibles don’t need to be registered and are available when you install them.
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Using the Bible Module

Searching

There are three ways to search for passages in the Bible module. You can select from the Book
menu, search by a specific passage, or use a keyword search.

-_ New International Version % | Book ¥ | Matthew 1:1-25 ,Q )
‘ v

Template ®

Before searching, you need to select a specific translation from the menu on the left. To use the
passage selector, click on the Book menu, then choose a book and chapter of the Bible; this will
load all the verses in that chapter. To search for a specific range of verses, type in the passage
and press Enter. The Bible passage search also recognizes shortened versions of book names. To
do a keyword search, type in your search term in the search box on the right.

Display Options

As with songs and other presentations, you can apply a template to Bible passages to format
them the way you need. Bibles also include several extra settings that are unique to Bible
passages.

¢ Verse Numbers: Checking this option enables verse numbers to be displayed in Bible
passages.

¢ Break on New Verse: Checking this will create new slides for each verse of a passage.

¢ Verse Refs: This option is only available if Break on New Verse is selected. Selecting this option

will display the verse reference on each slide.

Passage Each: Selecting this option will show the reference for the entire passage being

shown on each slide.

Passage Last: This option will only display the passage reference on the last slide.

No Reference: This option doesn’t display the passage reference on any slide.

Display Translation: Checking this option will show the translation that is being used.
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Bible Presentations

The Bible module is designed to make it easy for you to quickly pull up scripture with little or no
notice. However, it’s likely that you will know all the Bible verses being used ahead of time. This
is why in ProPresenter 5 we have made it easy to create presentations from a Bible search and
to add verses before or after the original search if necessary.

In ProPresenter 5 we’ve added a new option to add verses to an existing presentation instead of
having to merge multiple presentations together later.

Once you have found the passage that you want to use, click on the action menu in the lower-
left corner and choose either Save as Document or Copy to Current Document. The Save as
Document option will create a new presentation in your Library with the title of the passage.
The Copy to Current Document option will add the passage to the document that is currently
selected in the library or a playlist. This option makes it much easier for you to prepare a single
presentation for a sermon.

Let there be lights in the firmament of
heaven to divide the dav from th:

Save as Document
Copy to Current Document

You can easily add the previous or next verse to a passage by clicking on the Previous Verse or
Next Verse buttons. These two buttons are available in the Bible module as well as on Bible
presentations in the Library.

"“and let them be for lights in the
irmament of heaven to give light upon

After you have created a presentation for the Bible verses, you can format the slides the same
way you format song presentations.

While the Bible module hasn’t changed other than a few interface changes, one big change
related to Bibles is the use of templates. Previously the text and reference had the same
formatting unless you manually changed this after creating a presentation. In ProPresenter 5
we’ve added new functionality to templates allowing you to create individual text boxes for the
Bible text and the reference.
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To create a new Bible template that supports individual styles for the reference and verse text,
click on the Template button then choose Create New Template. This will open the Template
Editor, which is similar to the standard Editor.

0 | American Standar... | |  Book |
YJ v \J

- v V! Verse Numbers |V Break on Nsw\-

Default 9o |

Chunk5 center-center
typewriter right

"Charge them that aee rid
ot Ngheninded, for ha . P
Thehen, Bt o0 God, who) Save selected slide(s) as Template

Once the editor is open, add two text boxes to the slide and format the text how you want each
part to look. For the example below, each text box has had a line added around the box to make
it easier to see the two boxes.

o

Reference

Verse Text

After you have created your two text boxes, the next step is to name the two boxes so that
ProPresenter knows how to use this template in the Bible module. To name each box, select the
Object Properties tab on the right, select one of the text boxes, then choose either Bible Text or
Bible Reference from the Name menu. You can see in the image above that the Bible Text
option is shown while the text box that says “Verse Text” is selected. The image below shows
Bible Reference selected.

A

Name: Bible Referenc o

Fill Color |

Vv Line Color
. Line Width: 1
References Corner Radius: 0
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Props

Props make it easy to leave items on screen for an extended time, but are also easy to clear at
any time. Some common uses for props may be a lower-third graphic, a logo bug (a “bug” is a
broadcast term for a small graphic in the corner), or other persistent graphic that you want to
leave on screen.

A prop can remain on screen for just one slide, multiple slides, or for the entire presentation.
This layer is independent of other layers allowing props to be triggered at any moment. Props
adhere to transparency settings for those graphic formats that support them (.PNG stills or
animation videos with an alpha channel).

In ProPresenter 5, Props are not part of the default toolbar set. Click on the Customize button,
or right-click on the toolbar and select Customize. You can then drag the Props icon to where
you want it on the toolbar. You can also open Props from the View menu or by pressing Control-
P on your keyboard.

To activate a prop, click on the prop thumbnail. You can clear individual props by clicking on the
prop’s name in the toolbar. If you want to clear all of the props at once, add the Clear Props

button to the toolbar and use that. The Clear Props button is not included in the default toolbar.

If you want to change the Props module to a floating window, click on the icon in the top-right
corner. To return it to a docked position, click on the same corner again.

X | Active Props: x Prop #3 x Logo bug

EX gk d k¥ ¥}

» e

o
(=
(5]

©
[
s

1. Christmas borde‘ri | 2. welcome left 3. dark lower third

A R @ —O— [4

The first button in the lower-left corner is the Edit button. Clicking on this will open the Props
Editor where you can create as many props as you need. The second button allows you to set
transitions for the Props. The slider in the lower-right corner changes the size of the thumbnails.
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Clocks

To access the clocks module, customize the toolbar to add the Clocks icon, select it from the
View menu, or use Control-C on your keyboard.

The clocks module serves two purposes. The primary purpose is controlling clocks that are seen
only on the stage display. The second is controlling countdown clocks that can be shown on the
stage display, in a Message, or both.

This section will cover the basics of how this module works, and using clocks and countdowns on
the stage display and in messages will be covered later in this user guide.

Clock Format allows you to choose the way you want to display the system clock in
ProPresenter.

Time Elapsed starts counting up from zero from the time you start this clock. You can have this
clock start automatically when ProPresenter is opened by selecting the Auto Start option. When
this option is selected, the clock will begin running when when a presentation or piece of media
is selected.

You can rename the three countdown clocks by entering the new name in the name field.
Countdowns have two functions: Countdown timer and countdown to time. A countdown timer
is a standard countdown clock that runs for a given amount of time. The countdown to time
timer allows you to indicate a specific time of day of countdown to.

Note: When you change the name or time of a clock, press Enter or Tab on your keyboard to
confirm the change. Otherwise the previous name or time value will be used.

If you change the time, click the reset button to the left of the clock to update the time. Clicking
Stop will end the clock. Over Run allows a clock to continue running past zero. The buttons at
the bottom will start, reset, or stop all of the clocks simultaneously.

If you want to change the Clock module to a floating window, click on the icon in the top right
corner. To return it to a docked position, click on the same corner again.

X | Clock Components |

1:23PM 3

Clock Format:  12/10/10 3 12/10/10 1:14 PM

Time Elapsed: = [ Auto Start

Countdown Timers:
Name /pe Over Run

(Y

Start All Reset All Stop All
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Messages

In ProPresenter 5 it is now possible to have multiple messages formatted and ready to go on-
demand and even display multiple messages on the same screen simultaneously with different
formatting for each message. To open the Messages module, click on the Messages icon in the
toolbar.

There are two views available for the Messages module. The initial, collapsed, view allows you
to easily change the content of a message or a countdown clock. You can choose various
messages from the drop-down menu.

If you want to change the Messages module to a floating window, click on the icon in the top
right corner. To return it to a docked position, click on the same corner again.

Message " " i 3 e

Message: |

\ Show Message | ‘ Hide | []' Display: Until | Remove » l

When you open the Messages module, you can click on the drop-down menu to select from any
message that has already been created. If you need to add a new message, click on the plus
button. To edit a message, click the edit button to the right of the new message button.

Messages work using a combination of predefined text and token text. Tokens create content
dynamically depending on your needs. There are some included tokens or you can add any
custom token that you need. As you can see in the image to the above, the selected message
just has one text field called “Message”.

The image to the left shows a message that

WO BBl can be used to ask parents to come to their

Message + [7Z 1 child’s room. Along with the predefined text,
Countdown there are also two tokens in use. Using tokens
Nursery Call

makes it easy to create messages that need to
be updated regularly.

Message Text: Tol«:ll"’lls;”ﬂ!‘J=
W'”clr:po:.:::ef fcllllgaze come to Ef::: Instead of having to type this entire message
room # CRoom nUMber. Sanseq Time every time it’s need, the person running
gg:::gxx ProPresenter would only need to enter the
Child numhoer___ " child number and the room number. These two
B ) R oo number L+ B umbers will be formatted properly and

i 123 inserted into the rest of the message.

Room number: B-123 .
The bottom row of buttons control showing

' Show Message | | Hide | ISl oisplay: Until IRemove 1| and hiding a message ,as well as the transition
that is used when displaying a message.
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The Nursery Call number shown in the last image would appear on screen like the image below.
The template that is selected has a blue bar with white text that formats the message when it is

displayed.

gy

< Nere is love
vast as the ocean

v

Will the parents of child #123 please come to room #B-123.

The second function that the Messages module serves is to create on-screen countdowns for
your audience. If you don’t want to buy a countdown video for an event, ProPresenter makes it
easy to format a countdown clock that can be used over any of your own content.

As with regular messages, countdowns can contain text and a countdown. The two images
below show a countdown message and the resulting output. If you don’t want the clock to show
extra zeros at the front as time runs down, check the Strip Leading Zeros option.

Message -

Countdown
Nursery Call
Text: Tok -
session two First Name ) §
begins in Last Name
Countdown 1: H:MM:SS Message E]

Room
Clock
Elapsed Time
Countdown 1 v

Template: - Strip leading Zeros (¥ Room number
v e

Countdown 1 (D'¥  10:00 ¢ 00:03:58 Stop

[Show Message] [Hide] m' Dlsplay:_
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Mask Layer

The purpose of a Mask is to allow you to physically change the output of ProPresenter that is
shown on your displays or screens. With a Mask you can quickly change the output to be
virtually any shape you want. Masks are also perpetual items in ProPresenter; when you enable
a Mask, until you clear it, the mask will be visible. Masks are displayed when ProPresenter opens
if a mask was enabled when the program was closed.

Before using the Mask module you will need to customize your toolbar and add the Mask icon.
You can also open the Mask module from the View menu or by pressing Control-Shift-M.

The images below show three masks and the resulting output of each. Masks can be especially
useful if you are doing environmental projection, or need to project onto unusual surfaces. The
first and second mask are designed for environmental projection, meaning that instead of
projecting on a screen, the projector is pointed at a stage or wall. The first mask is designed to
keep the projector from shining on the choir and ceiling; the second is designed to keep the
project for hitting a screen on the middle of the wall. The third mask would be used to block out
everything but an oval projection surface.

° < | Clear Mask | -

SO

-
m

/@m0 oo

Only one mask can be active at any time. Masks also have their own transition time, but do not
have transition effects. To enable a mask, click on the thumbnail. To clear it, you must return to
this module and click the Clear Mask button or select the Clear Mask option from the Actions
menu. There is no shortcut button or key combination to clear a mask.

If you need to create more advanced masks, you can use Photoshop or other editors and import
images with transparencies. The Oval screen mask was made in Photoshop and the other two

were made in ProPresenter using rectangles.

Creating a mask may take a lot of work depending on your environment and needs, so be
prepared to spend more than just a few minutes creating it.
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Audio Bin

The audio bin allows you to control audio playlists directly from inside the program without
having to rely on an outside application to play music or sound effects.

To open the Audio Bin, click on the Audio icon in the toolbar, select Audio Bin from the View
menu, or press Control-A.

There are four components of the Audio Bin. At the top are playback
controls. Any audio file played from the Audio Bin or added directly to
a slide are controlled from here.

Library
. walk in

The top part of the Audio Bin lists the folders and playlists used to
organize audio files. All audio files added to the bin are listed under
Library, but can then be sorted into individual playlists. To add a folder
or playlist, click on the action menu button.

[ The lower section lists all the songs or sound effects in the selected

Tile Amst  Duration playlist. Clicking on the name of a file will trigger the audio to start
= Surely W... David ... 00:05:18 i . . . e
~hemedy David . 000535 «  PlAying. You can change the columns shown by right-clicking on one of

© Wewont. David .. 000234 % the headers (Title, Artist, Duration) and unchecking the options you
= Rain Down David ... 00:05:24 =i ’
' O,ForA ... David ... 00:05:08 i don’t want.

= Never Le... David ... 00:04:39 4|

—2:::,::.‘,. 3:::‘; — mﬁ; : Clicking the plus button at the bottom of the Audio Bin will open a

@) Can You... David ... 00:04:26 i Finder window for you to select the tracks you want to import. You can
@ Glory of I... David ... 00:05:14 4§ . . . . . .
also drag files directly from the Finder into the Audio Bin.

There are two audio types that can be imported into the Audio Bin.

Audio Tracks are full-length songs. Only one audio track can be played
at a time. If you have a song in the Audio Bin, you can drag it directly to
a slide or to the timeline to link it with a specific presentation.

m Sound Effects: These are short audio files that do not require full audio

control. Multiple sound effects can be played simultaneously. These
files can only be stopped with the Clear Audio or Clear All command.

The type of audio file is selected by default based on audio length. Longer files are Audio Tracks
and shorter files are Sound Effects. Right-click on the file to bring up a contextual menu to
change the audio files type.

If you want to change the playback behavior, you have three options: Loop, Go to Next, and
Stop. To change the behavior, right-click on the file and select the Behavior menu.

Either audio type can be dragged onto a slide to create an Audio Cue in the same manner as

media cues. When a slide with an audio-cue clip is clicked, it will automatically play the audio
clip. These clips are controlled by the playback controls in the Audio Bin.
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Timeline

ProPresenter 5 makes it easy to sequence slides in a timeline with or without an audio track.
This makes it easy for you to create presentations with custom timings between slides or to
record the slides to match a song. The ability to sequence slides with music is especially useful
for worship leaders who don’t have a band or someone to run lyrics for them since the song and
lyrics can be started with a single click.

To begin this process, click the Timeline button in the toolbar to open a new timeline for the
active song.

There are three ways to add slides to a timeline. The first is to drag the thumbnails from the
presentation to the timeline. The second is by clicking on the Slide Show button in the lower-
right corner of the timeline and selecting a preset value. This will space all of the slides out at
the same interval. The third way is to record the timeline.

Seconds: —) Rate: (] x r Duration Offset: ©
frrrr Ty ey T e [y S rrere Paassaasast Caaaataasrcana st e aaaaaaas e iaataans Erasasaas Trrrrr i

; .
GG

Audio files can be added to the timeline by clicking the Audio Track button, dragging a file from
the Audio Bin, or dragging a file from the Finder to the timeline. After you have added an audio
track, you'll see a solid green bar with the song name added and the duration value in the upper
right corner will show the total length in seconds. To remove an audio file, click on Audio Track
and select Remove Current Track.

Click on the Record button to ready the timeline for recording, then press the play button when
you are ready. If you have added an audio file, the audio will begin playing. To record slides to a
timeline, click on the slides like you normally would when going through a presentation.

The timeline has a hidden feature that isn’t available anywhere else in the program. If you click
multiple times in a row on a slide, each word will highlight in yellow during playback, creating a
karaoke or sing-along effect with the words. If you have a slide with five words, click once for
each word when that word is sung before moving to the next slide.

If you find that the audio track is playing too fast for you to accurately record the slides, you can
manually move the slide cues when you’re done, or you’re can slow down the song with the
Rate slider. This will cause the song to play slower so that you can have more time to anticipate
slides.

When you have finished recording a presentation, click the record and playback to stop the
recording. If you need a timeline to loop, click on the loop button to the left of the Duration time
box. Entering a value in Offset will move all of the slide cues by a given amount. Duration can
only be changed if there is no audio file attached to a timeline.

Clicking the info button in the upper right corner of a cue will let you change the cue label and
see any sub-cues that were recorded as part of the cue. The Seconds slider changes the time
scale of the timeline so you can see more or fewer slides at once.
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Using DVDs

en DVD Player

Show All DVD Olips.

-

CHANGED [ THE SHORT FiLM | .
-

LANDSCAPES [ 75 SEC FRAILER ]
!

A DIFFERENT VIEW [ 30 5S¢ TEASER | \
[ BONuS FEATURES |

AM@ED

AN INTER FACE EXPERIENCE i

: -00: A [ 4 ||san c “End
_1mw 00:00:02.00 Il T} (4 Lt 00.00:02.00 ~ Set temtem e
[ Title 01 Title
t—‘——‘L}—: — Chapter -~ Chapter
- - INTERFACE =

ProPresenter makes it easy to use a DVD during your presentation by allowing you to select
specific clips for playback from a DVD. In ProPresenter 5 we’ve taken it one step further by
building in DVD ripping capabilities. Instead of having to rely on a DVD working properly or
having to use third-party programs to rip DVD clips, you can now do that directly from within
ProPresenter.

There are two ways to use DVD content in ProPresenter. The first way is to create clips from the
DVD. When you create a clip, you aren’t saving the DVD content to your computer, you're
simply creating reference points to the DVD. The DVD must be in the computer in order for a
clip to be played.

To create a DVD clip, click on the DVD icon in the toolbar to open up the DVD player. You can
also open the DVD player by selecting it from the View menu. This will open the window shown
below.

Play the DVD as normal using the standard DVD controls at the bottom of this interface.
To create a DVD clip, click the Set buttons on the bottom right of the interface to set the start

and end points of the DVD clip. If you need to reset either the start or end point, click Clear and
reset the points. Next, choose a name for your clip and press the Save button.

Start Clear V" End Clear
00:00:02.00  Set ——lmmimm-—  Set
Title 017 Title
Chapter -- ; Chapter
Save Rip...
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Saved clips are shown in the column on the right. You can view clips for the mounted disc only
or click on the Show All DVD Clips checkbox to show all DVD clips that have been created in the
application. Selecting a clip will load it in the DVD interface. Once you have saved a clip, you can
click and drag it into a playlist or a presentation and it will be shown like other media.

Once you have saved a DVD clip, you can play it by clicking on the thumbnail in the column on
the right or after you’ve added it to a playlist or presentation. If you want to show an entire DVD
and would rather just cue it in the DVD player and not make a clip, click on the Full Screen
button next to the Eject button.

The DVD must be in the computer for a clip to be used. Saving a clip only creates a bookmark for
the clip on the disc. However, if you would rather not rely on the DVD to be in the computer,
you can actually rip DVD clips with ProPresenter 5.

Preparing to rip a DVD clip is the same as saving a clip. Set the in and out points and name the
clip, but instead of clicking on Save, click on Rip. You will see a progress bar while the clip is
being ripped.

Note: You will need to install the HandBrakeCLI. This can be installed on the DVD
Preferences panel within ProPresenter’s Preference menu. We also recommend installing
VLC to expand the types of DVDs you can rip content from.

When a DVD clip is ripped, the entire chapter that contains the In and Out point will be ripped.
As you can see in the illustration below, the orange segment represents the part of the DVD that
is selected to be shown. The In point is in Chapter 1 and the Out point is in Chapter 2. Both of
these chapters will be ripped in their entirety, but ProPresenter will automatically set the In and
Out points on the final clip to the correct spot. The DVD clip will be placed in your Foregrounds
bin in the Video/Image Bin. If you need to adjust the in or out point, you can do that within the
range of the video that was ripped.

Chapter 1 Chapter 2 Chapter 3

51
)
Cemsssssssceennancaees

Q

Note: If you are using an SDI card to send your output signal from ProPresenter you will not
be able to use this feature. DVD playback isn’t rendered the same way as other content in
ProPresenter, and can’t be shown via SDI.

© 2005-2012 Renewed Vision, Inc. Page 100 of 131



ProPresenter 5 for Mac User Manual

Displaying Web Pages

ProPresenter 5 allows you to easily share a live web page with your audience. The software
provides a web browser within the interface that is mirrored to the output display without all
the extra interface pieces such as address bars, bookmarks, and other distracting elements, so
the focus remains on the content of the page itself.

You will need to add the Web browser icon to your toolbar, select it from the view menu, or
press Control-W to access the web browser.

ProPreseater - Registered to: BETA TESTER

l.".‘: LJ o.g
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RENEWED VISION NEWS | ProPresenter for w

ProPresenter- ProVideoPlayer* ProVideoSync"~

E Videe
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Pro Presente

L LR 1A Products Downloas Store. Support About Us &

Click on the Show button in the top right corner of the browser to immediately display the
webpage for the audience to see. You can then interact with the website within the browser on
your computer and your audience will be able to see what you’re doing.

The toolbar also contains basic browser functions: Back, Forward, Refresh and Go. The globe
allows you to create a bookmark cue in a playlist by dragging the icon to a playlist. The square
button on the far right allows you to switch the browser window between a docked screen or a
floating window.

To display full-screen Youtube videos, you will need to disable the Display at Top Most Window
Layer setting in Preferences as was covered earlier in this manual.

Note: If you are using an SDI card to send your output signal from ProPresenter you will not

be able to use this feature. Web pages aren’t rendered the same way as other content in
ProPresenter, and can’t be shown via SDI.
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Stage Display

This feature requires an additional video output from your computer. Most users will need a
USB display adapter like the one available for sale in our store. If you have a newer 27” iMac,
you may have two Thunderbolt ports which can be used for your primary output and your stage
display out. Mac Pro users can optionally use a second video card.

To enable the Stage Display output, open Preferences and select the Display tab. If all three of
your displays are active, you will see three boxes on the Display preferences screen. Check the
box next to Enable Stage Display. This will activate the Stage Display output.

At this point, a purple box labeled SD will show on display preferences. This box may become
active on the wrong screen when you enable the stage display. If this happens, click on the stage
display box and drag it to the correct box representing your stage display.

The image below shows you what your display should look like. The arrangement may be
different on your screen depending on system settings. The blue box with the white bar at the
top represents your local monitor. The black box that says Out is your primary output. The
purple box with SD is your stage display output.

eOe Display

o=, O O g .

General Display Label DVD Live Sync Network Advanced Modules

Output Display Settings
4] Display at Top Most Window Layer
__!Scale to Fit Output Display
IZI Enable Stage Display Configure Stage Display

Edit System Display settings

Output Screen

Screen Width: 1600 Screen Color: | |l
e a
Screen Height: 1000 i N
Screen Position: |{ [H| p
Full Screen Update L

[} Corner Pin  Corners

Toggle Output
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There are two ways to access the configuration for
stage display. The first is by clicking on the Configure
Stage Display button on the Display preferences
screen. The second is by selecting the Window menu
and choosing Configure Stage Display. Both methods
open the same configuration display that is shown to
the left.

[¥| Current Slide () Text Only
[¥) Current Slide Notes

{1 1)

[¥) Next Slide () Text Only
[¥/) Next Slide Notes

If you have used the Stage Display in ProPresenter 4
you may notice a few new options that are available
for configuration now.

") Document Chord Charts
¥ Clock [] () Video Countdown [ |

) Time Elapsed

[¥) Countdown 1 ") Strip Leading Zeros

(¥ Countdown 2 () Use Negative Color ||
[¥) Countdown 3

You can now adjust the color and alignment of “Text
Only” options, show the countdown time of video
files, change the overrun color of clocks, and turn the
(/| Message Ml [ ] (/) Show Border and Label message flashing off as well as change its color.

[()Flash []
You can also show chord charts on the stage display
by linking PDF files to presentations.

At the top of the Stage Display Options window is a listing of all the available stage display
layouts that you have created. To add or remove layouts, click on the plus and minus buttons on
the right and name your new layout. You can create as many layouts as you need. Anyone who
is using an i0OS device with the stage display app can select from any available layout. Only one
layout at a time can be used with a wired stage display.

The next set of options controls how the current and next slides, and their notes, are shown. In
ProPresenter 4 the only Text Only option was the size of the text. In ProPresenter 5 we have
expanded this to allow you to change the alighnment of the text and to change the color of the
text. As you can see in the image below, the slide color has been changed to make it easier to
distinguish the slides, but the slide notes have been left white for additional contrast.

here is love loving-kindness
vast as the ocean as the flood

[CurrentSlideNotes ~______________________________MINextSlideNotes |
Notes for slide 1 Notes for slide 2

If you don’t select Text Only for the slides, a thumbnail image of the slide will be shown instead.
Media is shown as a thumbnail when it is assigned to either the current or next slide. Videos
can’t be shown on the stage display.

Slides notes are added in the Editor on the Slide Properties tab. If no notes are entered, nothing
will be shown in the Slide Notes boxes.
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The ability to show chord charts on the stage display is a new feature in ProPresenter 5. There
are three ways to add a chord chart to a song.

The first way is in the Document Properties menu located in the slide viewer at the top of each
presentation. This was covered earlier in this user guide. The second option is from the
Document Properties tab in the Editor. This option and the first are the same thing, but located
in different areas of the program. If your chord chart is a single-page PDF, link it to the song
using one of these two options so that it is displayed the entire time the song is active on the
stage display.

The third option is to add chord charts to individual slides. If you have a multi-page PDF where
each stanza has its own page, this is the option you will want to use so that you can link the
correct page with the slide.

In the Editor, click on the slide that you want to link a PDF page to
! EEE and then select the Slide Properties tab to the right. Click on the box
Add Chord Chart ¥ nhext to Chord Chart and then click on Add Chord Chart. This will
open a Finder window; browse to the location of your PDF and
select it. This same method is used to add a chord chart from either
of the Document Properties locations.

If your PDF is a single page it will be added right away. If it’s a multi-page PDF, you will see the
window shown below. Select the page that you want to link to a specific slide from the column
on the right, then click Save to use that page. You can use the same document on multiple slides
just by selecting different pages within the PDF. As with media, when a PDF is linked to a slide, it
will be shown until a different PDF page is selected. If you have multiple slides for a stanza, you
only need to add the PDF to the first slide of the stanza.

&) Select a Page

How Great Is Our God

Chris Tomin, Ec Cash

The splendor of the King 1
Clothed in majesty

Let all the carth rejoice, all the carth rejoice

He wraps himself in light

And carkness tries % hide

And trembles at His voice, 3

And trembles a1 His voice

Chorus
How great is our God

Sing with me
How great is our God

And all will see
How great, how great is our God

Age 10 age He stands

And tima is in His hands
Beginning and the End,
Boginning and the End

The Godhead, Three in One
Father, Spirit. Son

Cancel Save
4
|

When you enable the stage display option to show chord charts, a new box will be added to the
layout. You can move and resize the box to fit your needs. You select a slide with a linked chord
chart, it will be shown on the stage display. This is supported in the wireless stage display as
well.
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(V] Clock D ("] Video Countdown D

() Time Elapsed

(V] Countdown 1 (") Strip Leading Zeros

(V] Countdown 2 (] Use Negative Color D
(V] Countdown 3

The clock and countdown settings for stage display are linked to the Clocks module in
ProPresenter. You can start any clock from the Clocks module, or if you have a Countdown
Message that uses a clock that is enabled on the stage display, it will start with that clock as
well. Clocks on the stage display are useful for showing how much time is left before an event
starts and for showing a speaker how much time he has left.

There are three new features in the clocks section of the stage display. As with the text only
settings, we have implemented the ability to change the color of all the stage display clocks. We
have also added the ability to see how much time is left on the current video. This doesn’t
distinguish between background and foreground videos, so it will run the entire time a video is
being shown. Enabling this option is useful so that people on stage know how much time is left
in a video. Since clocks also support a function called Over Run, you can now have the clock
change colors when it passes zero.

The bottom set of layout options control how stage display messages are shown. Stage display
messages are unique because these are only shown on the stage display. In ProPresenter 4,
when you sent a stage display message, the box flashed to get the attention of those on stage.
In ProPresenter 5, you can change the color of the box when it flashes, or you can disable the
flashing effect entirely.

) Message B [ | (V] Show Border and Label

()Flash [ |

To access this feature, open the View menu and select Stage Display Message, add a button to
your toolbar, or press Control-S. Type your message and click the Send Message; the Message
box on the stage display will show the message and flash if you have that enabled. Clear will
remove the message completely and Hide removes the message from the stage display, but
doesn’t delete the message.

8006 Stage Display M

Type your message here.|

[ Hide J[ Send Message ]

4
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Twitter

One of the new features in ProPresenter 5 is Twitter integration. You can search by keywords or
hashtags, and moderate which results are shown on screen.

To open the Twitter module, click on the Twitter button in the toolbar, select it from the View
menu, or press Control-Shift-W. If you have a Twitter account you can log-in to authorize
ProPresenter to connect to Twitter.

Note: You can use the Twitter module without authorizing ProPresenter, but the search
results won’t be update in real-time. It is highly recommended that you authorize the
module so that it works as intended.

) (o)
twitterY Sign up>
Authorize ProPresenter to
use your account?

This application will be able to

« Read Tweets from your timeline.

* See who you follow, and follow new people.
« Update your profile

+ Post Tweets for you

orgot your password?

tion will not be able to

You can revoke access 1o any application at any time from the Ap

your Settings page.
By authorizing an application you continue 10 operate under Twitte
usage information will be shared back with Twitter. For more, see

0. In particular, some

After you have authorized ProPresenter to connect with your Twitter account, you can begin
searching for tweets to show on screen. You can search for a keyword or by using a hashtag. The
“Include Historical Search” option allows older results to be searched and used. If you have
authorized ProPresenter to access your Twitter account, the results will be updated in real-time.

0 Search Q propresenter e
™ Include Historical Search Template
thesoundbooth =
CTW Exclusive! #WFX Coverage of @propresenter 5 http://t.co/QW2I1RI YOU HAVE TO 0 o

CHECK THIS OUT! #ctin
11/17/11 10:51:55 PM

tekjojo
very excited about @renewedvision's propresenter 5! 0 Q
11/17/11 11:19:11 PM
thesnuffy
| am picking up an iMac that someone is selling, so that @HitTheRiver can have a more o Q
. stable computer for media and use #ProPresenter.
11/18/11 10:47:46 AM
elishalyx
RT @wireddaniel: The new @propresenter looks epic! http://t.co/u8uUEdGE 0 Q

11/18/11 11:11:11 AM
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Once you have search results available you can remove results, ignore them, or approve them.
Clicking the X will remove a results if it isn’t relevant or you don’t want to see it, and clicking the
check will approve the tweet. Approved tweets are moved to the column on the right and go
into the display rotation.

® @i
omie wen

You can choose a transition option that all of the approved tweets will use. In the lower-left
corner of the search results you can change the number of tweets that are loaded. You can
change the length of time each tweet is shown on screen as well as start and pause the rotation
from the lower-right corner. If you want to remove an approved tweet, click on the X and it will
be deleted from the approved list.

The preview shown in the image above is created using the template shown below. The
template is made of one image object (with a placeholder image) and three text boxes. You can
layout these objects however you want. You aren’t required to have all four objects, either.
After you have placed the objects on the slide, select the Object Properties tab for the slide.
Select each object and choose the appropriate option from the Name list. When you select this

template from the Twitter module, the appropriate elements will be placed on the slide based
on your template.

@screenname X: 200 W: 624
Default
TweetTextGoesHere89212345678 Bible Text
9312345678941234567895123456 . Bible Reference
7896123456789712345678981234 |V Twitter Text |
5678991234567890123456789112 - Twitter Screenname
3456789212345678931234567894 Twitter Image

Twitter Date

T ETITE AUTUT T —

April 18 5:47 PM

Tweets are currently there own slides and cannot be used as Props or Messages with other
content.
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Localization

ProPresenter 5 now has the ability to be localized into other languages. As of the release, only
Spanish and Korean will be included, but other languages will be added over time.

Instead of localizing the application directly, we have included language packs in the program
that are changed based on your system language settings. If you choose a language other than

Spanish or Korean, ProPresenter will use English as the default language.

To change the language settings, open System Preferences, select Language & Text and choose
the correct language.
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Modules

ProPresenter has included additional add-on modules since ProPresenter 3. In ProPresenter 5
we’ve made it easier to test these modules to see if they are right for you. We've also added a
new module and made some changes to others to further enhance their functionality.

Each of the features covered in this section of the user guide require an additional purchase of
an unlock code, and in some case, additional hardware is required. For information about
pricing, please visit our website.

Unlike a ProPresenter license, modules are licensed per computer and do not have a site license
option. If you require the same module on multiple computers, you will need to purchase
multiple copies of the module.

Modules are linked directly to a computer by a system ID Code and cannot be transferred as

needed. Modules can be transferred by our sales department in the event of hardware upgrades
or hardware failure.
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Demo Modules and Registering Modules

In ProPresenter 5 we have added the ability to easily demo any of our modules before
purchasing them. To access these options, open ProPresenter Preferences and click on the
Modules tab. You will see the interface shown below.

® (&) Modules

o) s B0 O o

General Dis;iay Label DVD Live Sync Network Advanced Modules

Modules
New Module Code: | +
ID Code: 2403116A35987679
Alpha Key
G ) Keyand Fill HD/SDI output designed for Blackmagic

Video Cards

Edge Blending
Buy) E An Extension to Multi-Screen that allows a seemless
blend between two or three projector screens

H
- _a

Master control of other ProPresenter Computers over

59 Master Control
*  the network

@ Multi-Screen
(Buy| =—:= Multiple Screen Options designed for Matrox Dual &
= = Triple Head-2-Go

SDI Output
(Buy| 0 Sends the output through SDI. Designed for
- Blackmagic Video Cards

(?2) Demo Modules

If you have purchased modules in a previous version of ProPresenter on this same computer,
they will have been automatically upgraded to ProPresenter 5 and will show has already being
purchased.

To demo the modules, click the Demo Module button at the bottom of the menu. This will
activate all of the modules in Preferences. When you activate a demo module, a watermark will
be applied to your output screen. Modules are also only active for the current session of
ProPresenter. When you close and re-launch the program, you will need to active the demo
modules again. Demo modules are intended for determining if they will fit your needs and are
not intended to be used in a live event. No temporary trial codes for modules will be available.

If you want to purchase a module, click on the blue Buy button. This will open the in-app store
where you can purchase the module. Modules purchased this way will automatically be
registered and activated on the same computer.

If you have purchased a module from a reseller or directly from our website, enter the 25-digit
code and then click the plus button to activate it. When you purchase a module, you will be sent
an activation code. You will need to follow the instructions in the receipt to activate that
number for the unlock code. You will also need the ID Code shown on the Modules tab in order
to link the code to the right computer.
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Alpha Key Module

The Alpha Key Module has two functions: (1) Blend ProPresenter’s content over incoming video
and then send that combined content back to a switcher or projector; (2) Generate a key and fill
signal that is then sent to a broadcast-quality switcher that is able to accept this type of signal.

When using method one, the actual compositing of the incoming video signal and the content in
ProPresenter (text or lower-third graphics normally) is done on the video card itself and then
sent back out to a switcher or projector. Choose this method by selecting Internal from the
drop-down menu.

The second method sends what are referred to as a “key and fill signals” to your switcher
allowing you to have a broadcast-quality signal. Choose this method by selecting External from
the drop-down menu.

®Nno Advanced

o mEE L HBOD @ oo [Eficd o

General Disﬁay Label DVD Live Sync Network MultiScreen Blend Advanced Modules

Import Video/Image Scale Behavior

Background: | Stretch to Fill +| Foreground: Scale to Fit

Video Playback
__ High Quality __ | Deinterlace __| Play Every Frame

Rendered Output Behavior
__|Render Output as Anamorphic __ Do not use FBO

__ Fast Transition Rendering __| Turn off Preview
Output Device Settings
M Enable Output Device: | Blackmagic Video Output
Mode: NTSC

Compression: | None

Alpha Key Settings
Blend: O

Alpha Channel: | Internal Key

These are the settings that you should set on the Advanced tab in Preferences.

e Check the box for Enable Output Device and choose the "Blackmagic Video Output".

o For the Mode setting, choose the appropriate setting whether it be standard definition (NTSC)
or High Definition (720p, 1080p).

o The Compression setting should be left blank.

Finally, you will need to specify what kind of keying you wish to do under the "Alpha Key
Settings" section:

o Disabled: This will output a full video out signal to your program and preview ports on the
Decklink card

« Internal Key: If you are using the Alpha Keyer as a downstream key, with a video input
coming into the Decklink card and one going out of it, then this is an Internal Key (be aware
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that audio is passed through the Decklink card when using this mode -- you cannot use the
Decklink audio outputs for sound out of ProPresenter when this mode is active).

o External Key: If you are sending separate key and

fill outputs to your broadcast video

switcher, this is the option you will choose. It sends the key signal through the preview out of
the Decklink card and the fill out of the program output.

Set the Blend to specify the maximum opacity of the video overlays.

NOTE: In order to get full HD output you must have a video display device attached to the
computer that is at least the resolution of the HD output. The reason is that everything is
rendered in the graphics card before output and we are unable to render out video textures
at resolutions higher than the display devices the computer is connected to.

For example, if you're trying to render out at 1920x1080 content to your output display,
your primary display must also have at least this resolution, if not higher.

In addition to configuring the Alpha Key settings on the Advanced tab, you will also need to

ensure a few settings are correct on the Display tab.

In Preferences, click the Display tab and ensure that

the Display at Top Most Window Layer is

not checked. You also need to manually enter the output resolution for your SDI signal. If your
output doesn’t look correct, verify that the Output Screen resolution is set for your SDI signal

and not the connected DVI or VGA display.

If you are still having trouble with the signal, open the Blackmagic preference panel in System
Preferences and make sure that Remove field jitter when video is paused is not checked and
that When not playing video, send is set to Black. Both of these options are on the bottom of

the Setting tab in the Blackmagic preferences panel.

|0

(2] (howan ]

Blackmagic Design DeckLink 7.9.3

Settings for your | DeckLink HD Extreme ... ﬂ

S04 & HOMI & Compor

45016 HOM & Componte Y O
{sewing 330

= Fdeo Levels

Audio Levels

Set output: ' SDI & HDMI & Composite (Y Ouﬂ

Set input:

For video and audio output connections

Composite Video (Y In) & Analcia )

Use video setup in NTSC:

Set black ref

For video and audio capture

@ At 7.5 IRE for use in the USA

(U At 0.0 IRE for use in Japan
Use 4:4:4 SDI on

"l Use 3Gb/s Single Link SDI not Dual Link SDI output

__ Use 1080p not 1080PsF

video output when possible

on SDI video output in capture

I [ Remove field jitter when video is paused I

Display HDMI 3D as: | Side by Side

I When not playing video, send: | Black $ !I

B

Set reference output timing:

Reference input not detected

3, 4 0
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Edge Blending Module

The Edge Blending module makes it easy and affordable to use edge blending in your
environment. Edge blending consists of two or three overlapping projected images that have the
overlapping regions adjusted to create a seamless blend. Because the outputs of each projector
have to overlap in order for blending to occur, the actual width of your output will be smaller
than the output resolution.

®NoO Blend

o mELB0D O &

General Display Label DVD Live Sync Network MultiScreen

=

Blend

Advanced Modules

Edge Blending Settings
@ Enable Data Doubling

Number of Projectors: = 3 -

Screen Size: 3 Width 1 Height

Output Resolution: 2400 x 600
Actual Resolution: 1800 x 600
Blend Area: 300 Total Blend: 600

¥ Enable Blending: IZC

Blend: O (;‘ 100%
Intensity: O ‘? 100%
Gamma: € %] 1

@

Min Black Level: €)

Display Patterns

Grid * ™ Grid Overlay Grid Size: 200

Display Pattern | I Center Lines || Center Circle

Before you make your adjustments to the Edge Blending Module, you will need to configure a
Matrox DualHead2Go or TripleHead2Go, as well as your computer and ProPresenter, for the
proper resolution. Refer to the Matrox Configuration section later in this user guide for details
on setting up a Matrox DualHead2Go or TripleHead2Go.

Once you have properly configured your computer and ProPresenter to work with double-wide
or triple-wide media, you can configure the Blend module. To start, check both the Enable Data
and Enable Blending boxes. Select the number of projectors (two or three) that you are going to
be using. To get started, you can enter the number of screens as your Screen Size, however,
entering the final screen width in inches will give you a more precise blend. The Blend Area and
Total Blend need to be positive values, so if they aren’t, double-check the screen resolution
settings.

The lower section is used to adjust your blend areas. The black-and-white box is actually the
representation of the curve being used to apply the blending adjustments. The three options--
Linear, Cubic, and Quadratic--will result in slightly different blends. Test each option to see
which works best for you since this varies depending on projectors and environmental factors.
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The four sliders allow you to adjust the values of the blend. You will need to spend some time
working with these to get the best blend you can. It's recommended that you start with the first
two sliders, Blend and Intensity, at 100% to help you establish a good baseline for adjusting your
blend. Gamma adjusts the brightness of the non-blended are compared to the blended regions.
If you find that your blended areas are brighter than the rest of your screen, you will want to
adjust this settings. Black Level adjusts the video black brightness. Since a projector doesn’t
display black, the brightness between the blended area and the rest of the screen may vary
slightly.

You will want to use the blend grid to help you align your projectors and get them as perfectly
aligned as possible before adjusting the blend settings. Getting the alignment perfect is critical
to being able to achieve the best edge blend possible. If your projectors are slightly out of
alignment, your blended area may be visible.

Due to the wide range of projects and their quality, achieving a “perfect” edge blend is quite
difficult, even for the most skilled person. Due to many factors, such as quality of the projectors,
age of the lamps in the projectors, number of hours each projector has been used, and even the
brand of the lamps in the projector, you may still see a slightly visible area where the images
overlap. This occurs with any edge blending solution.

If you aren’t familiar with edge blending, you may want to watch the tutorial on our website
first.
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Master Control Module

The Master Control Module allows one Master ProPresenter station to remotely trigger slides
and Video/Image Bin contents of one or more networked ProPresenter Slave stations. Each
Slave station can have its own content suitable for its output, so it can be the same or different
material than the Master station.

The ProPresenter stations must first be networked together. To ensure that all signals are
properly sent to the Slave stations we recommend using a wired network, though a wireless
network will work.

First, on each of your Slave stations, select Slave from the pulldown menu in the Master Control
section. The Name will be filled in with your computer’s name and the Port will be filled in with
a randomly generated port.

(&) (&) Network

DAL RSN X IS RO TS

General Dis;iay Label DVD Live Sync Network Advanced Modules

Master Control

} Slave : | Name: ‘Slave Station 1 ' Port: S

On your Master station, select Master from the pulldown menu in the Master Control section.
You will now see a list of any Slave stations that are found on the network.

e (3] Network

LE%EM%Q'IQ‘W N #

General Disaay Label DVD Live Sync | Network Advanced Modules

Master Control

Master > | Name: Master Station Port:
Name Reconnect
- Slave Station 1 Connect
- Slave Station 2 Connect

Click the Connect button for each of the Slave stations. Optionally, you can also check the
Reconnect checkbox which means that this station will always automatically connect when it
becomes available.

From this point, when you click on a slide on the Master station, the corresponding slide will be
displayed on the Slave station. For example, if you click on the first slide in the first playlist
document on the Master station, the first slide in the first playlist will be displayed on the Slave
station.
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Similarly, when you click on an item in the Video/Image Bin on the Master station, the
corresponding item will be displayed on the Slave station.

For more advanced configuration, you can change the Name or Port of the Slave station by
switching the Master Control pulldown menu to Off, making the necessary changes, and then

switching back to Slave.

ProPresenter 5 will include the Slave functionality for free, but the Master Control Module will
be an additional add-on purchase. Pricing is available on our website.
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Multi-Screen Module

The Multi-Screen module (formerly the Advanced Module) allows you to extend your projection
from one screen, to two or three screens. In ProPresenter 5 we have further expanded the
functionality of this module to make it even more useful.

Refer to the Matrox Configuration section later in this user guide for details on setting up a
Matrox DualHead2Go or TripleHead2Go. This section will assume that your computer and
hardware have been properly configured.

Once you have enabled the MultiScreen module, you can select either DualHead2Go or
TripleHead2Go from the drop-down menu. The configuration is identical within in ProPresenter,
but for this purpose, the settings are shown for TripleHead2Go.

The second section is the first new feature of the MultiScreen module. In previous versions of
ProPresenter, only one layout was supported, and that was whatever was configured here. In
ProPresenter 5 you can now create multiple multiscreen layouts that can also be cued with a
slide in a presentation. To create a new layout, click on the plus button and name the new
layout. Use the minus button to remove a layout.

The options in the lower half of this preference menu allow you to designate which elements
are shown on which screen. There are two additional new features here. The first is that you can
use different templates for individual screens. If you want to have large text on one screen, but
want to use lower-third text on the other two screens, simply create templates and then select
them on the correct screen. Live Video also has its own settings now. So instead of your live
video input following the Video/Image settings, it can now be shown on specific screens.

(S IONG) MultiScreen

— B @ C] ‘Ao

o) g B O @ B o -
General Display Label DVD Live Sync Network MultiScreen Blend Advanced Modules

Layout Settings
# Enable: TripleHead2Go =

This feature is intended for use with Matrox Products

. | | +
Message layout -
Text center, video tiled

Props: | [} B =)
Left Center Right
Slide: | @ ™ ™
Left Center Right
Alt Template: - - -
v v v
Video/Image: ™ ™ 4] [ Tile
Left Center Right
Live Video: ™ @) ™
Left Center Right
pvo: O ® O

Left Center Right
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Note: If you have certain elements in a template and they don’t exist in the Alt.
Template (e.g., Text Reveal settings), those won'’t be used. So if the certain screen is
doing a text reveal, but the Alt Template on the side screens doesn’t have a text box
with the same Text Reveal setting enabled, the full text will be shown immediately.

Once you have create the layouts that you want to use, you’re ready to go. If you create
multiple layouts, the one that is selected will be the one that is used by default. If you want to
change to a different layout on cue, right-click on a slide and select the appropriate layout from
the multiscreen cue menu.

Selecting Tile next to video with extend the same video or graphic all the way across your
attached displays. Leaving this box unchecked will cause your video or graphic to be shown on

each of the three screens.

DVD clips can only be shown on one screen. Due to how DVDs are played we aren’t able to
provide any additional control over the positioning of DVD playback.

Web pages will be shown stretched across all three screens.

A TH2G can also function as a DH2G, you just have to change the settings in the GXM Control
Panel and the MultiScreen panel.

The MultiScreen module doesn’t affect the Stage Display and both can be used simultaneously.
Masks can be used with a MultiScreen set up, but you will need to create a custom sized Mask

layer sized to your output resolution. To do this, open the Mask module, click on the Document
Properties tab, and enter a custom size for the resolution.
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SDI Output Module

The SDI Output module allows you to send true high-definition video to your video system.
When you enable this module, additional settings will be enabled on the Advanced tab in
Preferences.

Check the box for Enable Output Device and then choose the appropriate device and mode that
is required for your video system. This module is designed to work with Blackmagic video cards.
Other SDI cards may work, but they are not supported.

In Preferences, click the Display tab and ensure that the Display at Top Most Window Layer is
not checked. You also need to manually enter the output resolution for your SDI signal. If your
output doesn’t look correct, verify that the Output Screen resolution is set for your SDI signal
and not the connected DVI or VGA display.

If you are still having trouble with the signal, open the Blackmagic preference panel in System
Preferences and make sure that Remove field jitter when video is paused is not checked and
that When not playing video, send is set to Black. Both of these options are on the bottom of
the Setting tab in the Blackmagic preferences panel.

®Nno Advanced

W EELBO O & [Esk

General Display Label DVD Live Sync Network MultiScreen Blend Advanced Modules

Import Video/Image Scale Behavior

Background: Stretch to Fill :| Foreground: | Scale to Fit

Video Playback
__ High Quality __ Deinterlace __| Play Every Frame

Rendered Output Behavior
__|Render Output as Anamorphic __ Do not use FBO
__ Fast Transition Rendering __| Turn off Preview
Output Device Settings
fz‘ Enable Output Device: | Blackmagic Video Output
Mode: | NTSC

Compression: | None

Alpha Key Settings
Blend: O

Alpha Channel: | Internal Key
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Matrox Configuration

The Edge Blending module and the MultScreen module both require a Matrox DualHead2Go
(DH2G) or TripleHead2Go (TH2G). We do not support any other hardware for these two
modules.

If you have not already purchased a DH2G or TH2G and you aren’t certain which unit to get, use
this tool from Matrox to help you determine what you need to order. We recommend
purchasing Matrox units directly from us since we have confirmed that the bundles we provide
have all of the required hardware that you will need.

We recommend downloading the latest software driver directly from Matrox’s website rather
than installing the one on the CD. You can choose the version you need here.

The following instructions are only for the Digital Edition or DisplayPort Edition DH2G and TH2G.
If your computer has a MiniDisplayPort or ThunderBolt connection, you must use the
DisplayPort Edition.

After the software is installed, you can access the Matrox GXM Control Panel from your Apple
System Preferences.

enr System Preferences
[ <[> ][ ShowaAll (Q
Personal
2 M B @ o Q
Appearance Desktop & Dock Exposé & Language & Security Spotlight
Screen Saver Spaces Text
Hardware
> - = O
CDs & DVDs Displays Energy Keyboard Mouse Trackpad Print & Fax Sound

Saver

Internet & Wireless

N @ 3 =
MobileMe Network Bluetooth Sharing
System

K ¢ » ® § O 0 ©

e =3 -. -
Accounts Date & Time Parental Software Speech Startup Disk Time Machine  Universal
Controls Update Access

Other

3 . s

| W | &2 =

Growl Matrox GXM Perian teleport

Control Panel
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After you have opened the Matrox GXM Control Panel, click on Matrox Power Desk in the
toolbar and select Open Matrox GXM Control Panel. You will see the window shown below.

en Matrox GXM Control Panel

g

?

Supported Resolutions and Refresh Rates Active Resolut
2 * 800x600 60 Hz = | 3* 1280x!
3* 1024x768 60 Hz

ors and Refresh Rates

460 Mz

*) Stancard Wee

Reset to Manufacturer Settings

djust image quality

Agjust

Grapghics for Profesticnals

On the left side of this control panel, select the Number of Displays that are connected to your
DH2G or TH2G as well as the Aspect Ratio. After you selected these two options, use the drop
down menu to select your screen resolution and refresh rate. If you are using three screens and
located in the US, you may use 3*1024x768 60 Hz. If your screen setting isn’t in this drop down
menu, see if it is in the list on the right. This list shows all the possible Active Resolutions that
your computer will use. Use the arrows to add items from the menu to the list, or to remove
extra options from the list. Click Apply Changes then click on the Show All button to return to
System Preferences.

You are now ready to set the output resolution for your secondary display. In System
Preferences select Displays. When you open this control panel, you will have a separate control
panel for each of your attached displays. Do not change any settings on the primary display
control panel. If you are not able to see the control panel for the secondary display, press the
Gather Windows button to move the secondary display panel to your primary panel.

At this time, select the resolution you will be using with the Matrox Device. Remember that the
Mac thinks the Matrox device is just one extra wide display, it has no idea this resolution will be
broken down into different outputs by the Matrox device. You will want an output that is based
on the base resolution of each display (i.e. 1024x768 per screen for a TH2G results in a
resolution of 3072x768). Select this resolution on the secondary display control panel. Your
displays will briefly flash, and then they should be correctly configured.

For a full list of supported resolutions, refer to this page on Matrox.com.
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ProPresenter Remote

ProPresenter is able to be remotely controlled over a Wi-Fi connection by an Apple iPhone, iPod
touch, or iPad. You can find the ProRemote iOS application in the iTunes Store.

To enable the ProPresenter Remote within ProPresenter, open ProPresenter’s Preferences, click
on the Network tab, then check the Enable box under ProPresenter Remote Server. You will
also need to check one, or both, of the Controller or Observer options. You can change the
passwords if you want.

ProPresenter Remote Server
@Enable MControIIer Password: control

M Observer Password: observe

The Remote can operate in one of two modes. If you are in Observe mode, the application will
follow along with the slides as they are advanced in ProPresenter. If you are in Control mode,
then selecting a slide of any presentation will cause ProPresenter to switch to that presentation
and select that slide immediately.

Launch the ProPresenter Remote on your iOS device. If the device is correctly connected to a
Wi-Fi network with the computer, you will see the computer name listed. If multiple computers
are listed, select the one you want to connect to and enter the observe or control password,
then tap Connect.

The image below is from an iPad. If you are using the remote on an iPhone or iPod Touch, the
login screen will look slightly different.

wkemote

Password:

Presentation Machine ..

Connect

To display the Clear Commandes (i.e. clear background, clear text, etc), press the eraser button in
the upper right corner of your device.

Playlists Logout
™ Library >
E] Sunday Playlist >
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Remote Stage Display

The Remote Stage Display app for iOS devices allows you to use your iPhone, iPod, or iPad as a
wireless stage display. This is especially useful for portable churches, or churches on a budget,
who don’t want to setup extra displays or run extra cables.

To enable the Remote Stage Display within ProPresenter, open ProPresenter’s Preferences, click
on the Network tab, then check the Enable box under Remote Stage Display Server Settings.
You can change the default password if you want. Unless you need to use a specific port to
connect, leave this option blank.

Remote Stage Display Server Settings

@ Enable Password: password

Port: Optiona

Once you have enable this setting, you are ready to connect your iOS device to ProPresenter.
Launch the app on your device and enter the password you selected. Your computer and iOS
device need to be on the same network to interact with each other. Certain network settings
may interfere with the connection, so check with your IT administrator if you think everything is
configured properly with ProPresenter and the app.

Once the app loads, you will see a layout similar to what you see on a physically connected stage
display. If you have configured multiple stage display layouts in ProPresenter, you can tap the
screen on your device to select from the list of available layouts. This allows every person using
the remote stage display app to have a different layout on their device if needed.

If your iOS device supports connecting to an external display, you can use the stage display app
on a large display as well.

To log out of the app, either close ProPresenter, or tap the screen again and click on Log Out.
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Display Patterns

ProPresenter 5 has three different display patterns built into the program to make it easier for
you to adjust projectors. These can be found by clicking on the View menu and selecting the
pattern you want to use from the Display patterns sub-menu.

Color Bars is useful for calibrating the color of your projectors.
Blend Grid makes it easy to configure overlapping projector images.
Focus provides five points of reference for focusing and adjusting key stone.

© 2005-2012 Renewed Vision, Inc. Page 124 of 131



ProPresenter 5 for Mac User Manual

Backing Up and Transferring Files

If you are transferring to a new computer or adding an additional computer to your inventory,
you may want to create a duplicate copy of ProPresenter on the new computer. Doing this is
fairly simple, but does involve several steps.

To protect yourself against hardware failures or accidental file deletion, you may want to
occasionally create a backup version of your Library folder(s) since this portion of ProPresenter
requires the most work to rebuild.

You will need to copy the following files and folders from your original computer into the same
locations on the new computer. Before you continue, make sure that ProPresenter has been
installed and registered on the new computer, and that ProPresenter is closed on both
computers.

You will need to open a new Finder window to navigate to these locations. The easiest way to
move the files will be to create a new folder on your desktop or external storage device and
copy each of these files to that location. After you move these files to the new computer, you
will be replacing the default versions of each of these. When prompted, confirm that you want
to replace the file or folder.

Library

By default, the Library folder is stored in your Documents folder. Copy the ProPresenter 5
folder. Inside of this folder are all of your Library documents ending in .pro4. If you have any
custom libraries stored in other locations, copy those as well. Place custom libraries where you
want them to be stored; do not place the folder inside the ProPresenter 5 folder.

Preferences

This file contains user-defined preferences. If you don’t mind resetting the preferences on your
new computer, you don’t need to copy this file.

In Finder, click on the Go menu and choose Home. Once Finder has opened this location, open

the following folder in order: Library > Preferences. Scroll down in this list until you see a file
called com.renewedvision.ProPresenter 5.plist. Copy this file to your temporary folder.

Program Files
This folder contains all the information related to playlists (Library playlists, Video/Image Bin
playlists, and Audio Bin playlists), as well as any Bibles you have created, and templates, props

and masks.

In Finder, click on the Go menu and choose Home. Navigate to Library > ApplicationSupport >
RenewedVision. Copy the ProPresenter 5 folder to your temporary location.
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Keyboard Shortcuts

The following section outlines all of the keyboard shortcuts that are available in the program.
Learning keyboard shortcuts for many of the common tasks you do will speed up your work flow
and make you more efficient in ProPresenter. The majority of these shortcuts are listed in the
menus at the top of the program and are grouped according to the menu they appear under.
The last set of short cuts are not listed under a menu, but are useful to know when editing
slides.

ProPresenter Menu

¢ Preferences: Command-, (Command and the comma key)
e Empty Cache: Control-Command-E

¢ Hide ProPresenter: Command-H

¢ Hide Others: Command-Option-H

¢ Quit ProPresenter: Command-Q

File Menu

o New Presentation: Command-N
¢ Save All: Command-S

¢ Save As: Shift-Command-S

e Print: Command-P

Edit Menu

¢ Undo: Command-Z

¢ Redo: Shift-Command-Z

e Cut: Command-X

Copy: Command-C

Paste: Command-V

Paste and Match Style: Option-Shift-Command-V

Duplicate Slide: Shift-Command-D

Select All: Command-A

Deselect: Command-D

¢ Show Spelling and Grammar: Command-: (Command and the colon key)
e Check Spelling: Command-; (Command and the semicolon key)
o Special Characters: Command-Option-T

Action Menu

o Next Slide: Right Arrow

¢ Previous Slide: Left Arrow

o Next Background: Command-Right arrow
¢ Previous Background: Command-Left arrow
e Clear All: F1

e Clear Slide: F2

o Clear Background: F3

o Clear Props: F4

o Clear Audio: F5

e Logo: F6

e Live Video: F7

¢ Search Library: Command-F

e Show Library Selection: Command-L
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¢ Show Slide on Stage Display Only: Command-0 (Command and the zero key)

View Menu

e Audio Bin: Control-A

¢ Bibles: Control-B

o Clocks: Control-C

e DVD: Control-D

o Editor: Control-E

Format Bar: Control-F

Info Center: Control-I
Mask: : Control-Shift-M
Media Browser: Control-K
Messages: Control-M
Props: Control-P

e Resources: Control-R

¢ Song Select: Control-Shift-S
e Timeline: Control-T

o Twitter: Control-Shift-W

¢ Video/Image Bin: Control-V
e Web: Control-W

L[]

Format Menu (Used in the Editor)
¢ Bring to Front: Shift-Command-F
¢ Send to Back: Shift-Command-B

Font Menu

e Show Fonts: Command-T

¢ Bold: Command-B

e ltalic: Command-I

e Underline: Command-U

e Bigger (text): Command-+

e Smaller (text): Command- - (Minus)
¢ Show Colors: Shift-Command-C

e Copy Style: Option-Command-C

¢ Paste Style: Option-Command-V

Text Menu

e Align Left: Command-{

e Center: Command - |

e Alight Right: Command-}

e Copy Ruler: Control-Command-C
e Paste Ruler: Control-Command-C

Window Menu

¢ Close (Panels Only): Command-W

e Show / Hide Output Window: Command-1

o Show/Hide Stage Display Window: Command-2

Shortcuts for splitting content on slides in the Editor
¢ Split a slide at the cursor: Option-Return
¢ Send text after the cursor to the next slide: Option-Shift-Return
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Troubleshooting

While we hope that you never have any problems with ProPresenter, should something go
wrong, please use this section to resolve any problems that you are having. Please try the
following common solutions before contacting us. Most problems are resolved with one of
these solutions.

Software Update

If you do experience an issue, please first make sure that your software is current. You can do
this by clicking on Check for Updates in the ProPresenter menu. If you cannot access the
program to check for updates, please go to our website and download the latest version.
Updating or reinstalling the program will never wipe out any of your data.

If you are trying to open ProPresenter and the icon bounces in the Dock and then quits, you
need to reinstall the program by downloading the latest version from our website.

Reset Preferences

Note: Before resetting preferences it is recommended that you make notes of your
preference settings (ProPresenter menu, Preferences) because they will be reset to factory
default settings.

The first step to resolving many small problems is to reset the ProPresenter preferences. The
first way to do this is from the Preferences menu. Select the General tab then click the Reset All
Preferences button at the bottom of the window. Quit ProPresenter, reopen it, and see if the
problem you were having is still present. If you are still having problems, or if you are unable to
open ProPresenter to perform this step you will need to manually reset the preference file on
your computer.

To manually reset the preference file you will need to use the Finder. Make sure that
ProPresenter is completely closed before continuing with this step.

Open a new Finder window and then press Command-Shift-G. When the “Go” window opens,
type ~/Library/Preferences and then click Go. Scroll down in this list until you see a file called
com.renewedvision.ProPresenter5.plist.

Since this contains the general preferences in ProPresenter, you may want to just move this file
to your Desktop while you test to see if this fixes your issues. If your problem persists, close
ProPresenter and place this file back in the above location, replacing the new copy of this file
that’s now there. If your problem has been resolved, you can delete this file from your Desktop
since you confirmed it isn’t working. You will need to reset the preferences in ProPresenter
manually after this.

If resetting Preferences does resolve the issues you're experiencing, please contact our support
team or post a message in our user forum.
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Rebuilding ApplicationSupport Data

If reinstalling the application and resetting Preferences didn’t resolve the problems you’re
experiencing, there may be a corrupt file in your Application Support data. There are two ways
that you can test this, you can rename or move the folder all at once, or you can test individual
items within the Application Support folder.

To access the Application Support folder for ProPresenter, open a new Finder window, press
Command-Shift-G and type ~/Library/ApplicationSupport/RenewedVision. You can then name or
move the ProPresenter5 folder, or test individual items within that folder.

The most common issue that is resolved here is a corrupt Video/Image Bin. If you open the
ProPresenter5 folder you will see an item called “media.pro5pl”. Move this file to your Desktop
or modify the name then launch ProPresenter to see if the program works now. The Video/
Image Bin will be empty, but the program will work again. You can then delete the original
version “media.pro5pl” since there isn’t a way to recover the data.

Other problems may be caused by corrupt thumbnail data. Deleting the two items with
“Thumbnails” and “PosterFrames” in their names (a folder and .plist file for both) will clear the
stored thumbnail data and allow ProPresenter to rebuild this information.

If you continue having problems even after those steps, work your way through the files by
modifying the file name and testing ProPresenter after each change by closing and opening the
program.

Licensing Issues

If you purchased a ProPresenter single or site license directly from us, you should have received
an email with your registration name and 25-digit unlock code. If you purchased through a
reseller, you would have been sent a shorter code that needs to be redeemed. You can do this

by going to www.renewedvision.com/registration. Once you have your 25-digit code, keep a

copy of it for your records in case you need to install ProPresenter on a new computer.

If you are having trouble entering your license information, please first make sure that you are
copying and pasting your Registration Name and Unlock Code from the email that you received.
Dashes are required in the unlock code.

If you get a message saying “Invalid Unlock Code” ensure that you are using the code for the
correct version of ProPresenter. Codes do not work between versions of ProPresenter.

If you cannot get ProPresenter to accept your registration information and you have verified it is
correct, or if you have to enter your registration information every time you open ProPresenter,
follow these steps.

e Quit ProPresenter.
e Open a new Finder window, press Command-Shift-G and type /Library/Application Support/.
o If there is a folder named “RenewedVision” continue to the next step. If there isn’t, click on
File>New Folder and create a folder with that name.
e Open the “RenewedVision”. If you should see a folder named “ProPresenter 5”. If not,
create this folder before going to the next step.
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e Open the “ProPresenter 5” folder. If there is a file named “mapdata”. Delete the file. You
can now try to register your copy of ProPresenter. If this file didn’t exist, go back up to
where you see the “RenewedVision” folder again.

e When you see the “RenewedVision” folder, single-click on the folder and press Command-I
on your keyboard to open the Info panel.

e Expand the options under Sharing & Permissions at the bottom. Click on the lock icon and
enter your password for the computer.

e Change the permission on each of the listed users to “Read & Write”.

e Click the Action menu (the box with the gear icon) and select “Apply to Enclosed Items”. You
should now be able to register your copy of ProPresenter.

If you continue to have issues after trying all of these troubleshooting steps, please contact our
support team or post a message in our support forum to get further help.
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Additional Resources

Tutorial Videos
There are a number of quick tutorial videos that will introduce you to the basics of many of the
new features in ProPresenter 5. These are not intended to be training resources, but are simply

to help you understand how features work and where things are located.

Click here to watch the tutorials.

FAQ

There is a comprehensive Frequently Asked Questions section on our website. If we receive
questions repeatedly we create a new FAQ on this website so that others can easily find the
answer without needing to contact support. This makes it easy for you to find answers after-
hours and to save yourself some time by not having to call. Not every question will be here, so if
you can’t find an answer, try one of our other resources or contact us directly.

User Forums

Our user forums are a great place to get help from other users and from our support staff. You
must create an account in the forums in order to post messages or replies, but this is a free
resource.

Phone and E-mail

You can find our direct contact information on our website.

Twitter

You can find us on Twitter using these names: @renewedvision, @propresenter, @rvsupport.
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